WELCOME TO TIMECLOCK PLUS ONDEMAND (BASIC)!

To access the bookmarks go to View > Navigation Panels > Bookmarks.

This Quick Reference Guide provides basic information to immediately start using TimeClock Plus OnDemand (Basic). The User Reference Guide is also available with detailed information on functions and features of TimeClock Plus OnDemand (Basic).

I.I. How to Use this Guide

User Reference Guide
Throughout this guide, there will be references to sections in the User Reference Guide. These will be indicated by an open book.

Notes
Notes provide important information to consider when configuring or using TimeClock Plus.

Warnings
The warning icon brings to your attention a very important detail concerning the setup or use of TimeClock Plus.

Tips
This icon designates tips and shortcuts that may aid you while using TimeClock Plus.
I.II. System Requirements

Client Requirements

Window Platforms
- Windows XP with SP 3
- Windows Vista Home Prem.
- Windows Vista Ultimate
- Windows Server 2003
- Windows Server 2008
- Windows 7

Hardware
- 1 gigahertz (GHz) Pentium processor or equivalent (2 GHz or higher recommended)
- 512 megabytes (MB) or more of RAM (1 GB or higher recommended)
- 100 megabytes (MB) or more of hard disk space

Software
- Internet Explorer 8
- Firefox 3.5 or higher in Windows or Mac (recommended)

Supported, but not recommended:
- Internet Explorer 7

Internet Connectivity
- Broadband internet: 1 Mbps down (1.5 Mbps down or higher recommended)

I.III. Customer Service

There are 3 ways to contact the Customer Service department:

Phone: (325) 223-9300
E-mail: support@timeclockplus.com
Chat: http://www.timeclockplus.com

For E-mail, please include your company name and serial number.

Customer Service Representatives are available from 9:00–5:00 CST, Monday thru Friday (excluding standard holidays) for questions about TimeClock Plus OnDemand Support sent via E-mail typically receives a reply within 2 business days.

After your initial 90 days of support have expired, further support will be available on a fee basis. Please contact your Sales Representative or DMI Technical Support for more information.

Data Management Inc. reserves the right to modify the Technical Support policies without notice.

© Data Management, Inc. All Rights Reserved. This documentation may change without notice.

Rev. 2/21/11
I.IV. Important Concepts of the Application

Users

Users are individuals with access to management applications such as WebManager. The following are examples of what a user would do: add employees, edit or approve hours, override clock restrictions, and run a report.

Employees

Employees are individuals with access to WebClock or a Remote Data Terminal (RDT). The following are examples of what an employee would do: perform clock operations (e.g., clock in and out) or view and approve hours. For information on adding an employee, please refer to 2.0. Adding and Editing Employees.

Job Codes

For each employee, time is tracked with a job code. They may be as simple as Hourly, Sick, and Vacation or set up according to department or task. There are two types of codes: clockable and non-clockable. Clockable codes are used by an employee when clocking in. Non-clockable codes track time that a user enters for the employee (e.g., sick or vacation). For information on adding a job code, please refer to 1.1. Adding and Editing Job Codes.

Missed Punches

In earlier versions of TimeClock Plus, if an employee forgot to clock in and tried to clock out, the employee would be unable to clock out. If an employee forgot to clock out of the last shift and tried to clock in, the employee would be unable to clock in. Missed punches, if enabled, create the missing clock in or the missing clock out, flag it as a missed punch for manager review, and allow the employee to proceed with the clock operation.

WebManager

WebManager is an application that allows you to manage employee information, hours, and run reports. It offers a variety of tools for reviewing, modifying, and monitoring information.

WebClock

WebClock is an application that allows you to perform clock operations from your PC or view hours, read management messages, and more.
I.V. What’s New in TimeClock Plus OnDemand (Basic)

There are several new and improved features in TimeClock Plus OnDemand (Basic). Many of the changes are described below.

WebManager

Default Criteria

- Added system-wide criteria and section-specific criteria.

Global Modification

- Added ability to globally change the manager for one or several employees.
- Added ability to globally raise the salary for one or several employees.

Edit Hours

- Added ability to delete multiple shifts at a time.
- Added ability to edit rounded times.
- Added an option to perform punch rounding and an option to perform break rounding when adding hours.
- Added “Other” approval for someone other than the manager or employee.
- Added an option to display the ID of the last user who approved a shift.

Reports

- Added support to render a report in a PDF format.

Who’s Here

- Added an Hours tab to reflect each employee’s total hours and status.
- Added a Leave tab to reflect anyone who is currently in a leave job code (e.g., Sick or Vacation).

Master Job Code List

- A job code can be added using another job code as its template.
- Added a break rounding simulator.

TimeClock Defaults

- Added Password Policy section to allow restrictions on each type of password. For example, require at least a 10 character password containing at least 2 uppercase, 2 lowercase, and 2 numeric characters.
- Added option for employees to change their Pin in WebClock.
I.VI. Initial Setup of a Company

The initial setup involves four steps:

1. Create the job codes (see Section I).

2. Create the employees (see Section II).

3. Assign the job codes to the employees (see 2.0.4.2.).

4. Configure WebClock and, if you have a Remote Data Terminal (RDT), activate and configure it:
   - To configure what options appear in WebClock or on an RDT, refer to 8.0.1. Miscellaneous in this guide.
   - For WebClock, advanced configuration is discussed in Section IX: Configuring WebClock of this guide.
   - To activate an RDT and for advanced configuration, refer to the appropriate section in the Hardware portion of this guide.
SECTION I: MANAGING JOB CODES

1.0. What is a Job Code?

Time is captured and tracked with a job code. In TimeClock Plus, every employee must be assigned at least one clockable job code in order to clock in and out of the system.

There are two types of job codes: **clockable** and **non-clockable**. Clockable codes are used by employees when clocking in with WebClock or a Remote Data Terminal. Non-clockable codes are used by a manager when entering time in WebManager (such as sick or vacation time since employees won’t typically enter their own sick or vacation time).

Clockable Codes

Some companies create only one clockable code because they are only tracking attendance and not the breakdown or distribution of hours between areas. However, most companies create several job codes per employee because they require a breakdown of how hours and areas are being utilized. Some examples of clockable codes are:

- A “General” or “Hourly” job code for everyone if a breakdown is not desired.
- Department-based job codes (e.g., Administration, Marketing, or Shipping).
- Positional job codes (e.g., Mechanic, Welder, or Driver).
- Project-based job codes (e.g., Construction or Assembly).

Non-Clockable Codes

Non-clockable codes (or “Leave” codes) are codes that the employee will not clock into. Non-clockable codes are entered manually by management for leave such as sick, vacation, PTO, and others.

Once you have created job codes in TimeClock Plus, you will need to assign them to your employees. This can be done on an individual basis or globally.

1.1. Adding and Editing Job Codes (Master Job Code List)

Adding a Job Code

When adding a job code, you can use an existing code as a template. This means that you can add a code and have it inherit the settings of another. To do this, highlight the existing code, click Add, and then Yes when asked to use it as a template.

1. In WebManager, go to Configuration > Master job code list.
2. Click Add.
If you wish to create a job code with the same settings as an existing code then highlight the existing code, click Add, and OK to confirm.

3. Enter a job code number.
4. Enter a description (optional).
5. If the code is non-clockable then remove the check next to the option “Code is clockable”.
6. If the code is for leave (e.g., Sick) then place a check next to Leave code.
7. After adjusting any other settings as needed, click OK.

Editing a Job Code

1. In WebManager, go to Configuration > Master job code list.
2. Double click the job code or highlight it and click Edit.
3. Make any desired changes and click OK.

Deleting a Job Code

We recommend deactivating a job code instead of deleting it in order to preserve the history of hours in job code. This is done by editing the code and un-checking the “Active” option.

1. In WebManager, go to Configuration > Master job code list.
2. Highlight the job code and click Delete.
1.2. The Interface

In the Master Job Code List, there are three tabs: “All”, “Regular Codes”, and “Leave Codes”. A complete list of codes is available under the “All” tab and that list is broken down under the two other tabs - one for regular codes and the other one for leave codes. These tabs are used to simplify the management of your job codes.

The list may be sorted by the **Job Code** or **Description** columns.

There are several buttons at the bottom of the screen for managing the Master Job Code List. Among these, the following buttons are the most important:

- **Add** – This button allows you to add a new job code.
- **Edit** – This button allows you to edit the highlighted job code.
- **Delete** – This button allows you to delete the selected job code. **We recommend deactivating the job code instead of deleting it in order to preserve the history of hours in that job code. This is done by editing the code and un-checking the “Active” option.**

1.3. The Job Code Settings

The job code settings in the Master Job Code List are the default settings. When you assign a job code to an employee, the settings for that job code in the Master Job Code List will apply. Many of these settings may be overridden on a per employee level.

Many of the critical settings are listed below:
A complete list of the settings may be found in the User Reference Guide: Section 3.3. The Job Code Settings.

Information Tab

Please note: The settings below will not affect employees who have already been assigned the job code you are editing. Settings in the Master Job Code List serve as the default settings and affect employees who are assigned the job code after the fact. If the job code has already been added to an employee (Add/Edit) then you will have to adjust these settings at the employee level (Add/Edit) or adjust them globally (Global Modification).

**Job Code number** – This is a 10 digit number that identifies the job code. This field is required when adding a job code.

**Description** – This is a 30 character name that identifies the job code.

**Active** – This option affects the availability of the job code. If a job code is no longer necessary then we recommend you deactivate it instead of deleting to preserve the history of hours.

**Leave code** – If checked, the job code will be classified as leave. In the Master Job Code List, codes that are classified as leave codes will appear under the Leave Codes tab. There is also a tab in Who’s Here that will show anyone who is currently in a code that is classified as a leave code.

**Code is clockable** – If checked, the code will be available and viewable to the employee when clocking in from WebClock or a Remote Data Terminal. If unchecked then the job code will become non-clockable which means it will only be available to a manager when adding or editing time manually via WebManager (e.g., entering Sick or Vacation time).

**Hours worked earn overtime** – If this option is checked, the hours for this job code can earn overtime. For example, if an employee is configured (Add/Edit > Overtime tab) to reach overtime after 40 hours then all hours worked over 40 in this job code will earn overtime. The employee will receive the appropriate overtime multiplier times this job code’s rate.

**Hours worked count toward overtime** – This is checked when Code earns overtime is enabled. If Code earns overtime is not enabled, but this option is enabled, hours for this job code won’t earn overtime, but will count towards it. For example, if an employee is configured to reach overtime after 40 hours, works 32 hours in a job code that doesn’t earn, but does count toward overtime, and then works 10 hours in a job code that does earn, the employee will have 2 hours of overtime because the 32 hours earlier in the week counted toward overtime. If the employee just worked 42 hours in a job code that doesn’t earn, but does count toward overtime, the employee will be paid 42 regular hours because it doesn’t earn overtime by itself.

Additional Settings (Optional)

There are additional settings that control advanced features.
• All hours in this job code may be forced into Overtime 1 or Overtime 2.
• Tracked fields may be collected. These are amounts (whole or decimal) that can be collected after a clock operation. They are ideal when tracking, for example, the amount of mileage for a driver or the amount of tips for a waiting staff.
• Breaks may be automatically deducted after x hours are worked.
• Manual breaks (where the employee uses the Break button) may be paid or unpaid (up to four different breaks may be created and configured differently).
• A minimum break length may be defined for each break type.
• Break lengths may be rounded based on when the employee returns from break.
• The job code may be configured to record a minimum of x hours if the employee clocks out before the minimum (Segment Minimum).
• The job code may be configured to record x hours and automatically clock out (Auto Out).

The other settings are described in the User Reference Guide: Section 3.3. The Job Code Settings.
SECTION II: MANAGING EMPLOYEES

This section of the Quick Reference Guide provides instruction on the basic processes related to managing your employee records. This includes adding and editing, removing, suspending, and terminating employees.

2.0. Adding and Editing Employees (Add/Edit)

There are only four fields required for employees to clock in/out - the Employee ID number, First Name (Info tab), Last Name (Info tab), and a clockable job code (Jobs tab). The remaining fields can be filled out later if you prefer.

It is recommended that you enter the employee’s “Hire Date” as other features depend on this information such as criteria and employee reviews.

2.0.1. Adding an Employee

⚠️ Before proceeding, ensure that all job codes have been created. For more information, please refer to Section I: Managing Job Codes.

1. In WebManager, go to Employee > Add/Edit.
2. Click Add Employee.

3. Enter the employee number (up to 10 digits) or click the Next Available button and the next available number will be automatically entered.
4. Click OK.

⚠️ Base new item on which template is a list of employee templates. Templates are not available in TimeClock Plus OnDemand (Basic).
5. Enter a **first** name and **last** name (required).
6. Enter a **hire date** (this is optional, but recommended).
7. Click on the **Jobs** tab.
8. Click on the **Add** button.
9. Select a job code for this employee and click **OK**. Repeat this for every job code that needs to be assigned. Add at least one clockable job code to each employee.

Completion of the remaining tabs is optional.

For more information, please refer to the **Employee Information and Settings** in the User Reference Guide found on the CD.

10. Click **Save**.

**Note!**

*If a job code in the list is grayed out then its state is inactive at the employee level (select the code, click **Edit**, and look at the **Code is active** check box) or its state is inactive at the master job code level (Master Job Code List).*

**Note!**

Once you have added a clockable job code, your employees may begin clocking in and out using WebClock or a Remote Data Terminal.

### 2.0.2. Editing an Employee

1. In WebManager, go to **Employee > Add/Edit**.
2. Double click on an employee in the list on the left (or enter the ID and press Enter).
3. Make any desired changes.
4. Click **Save**.
2.0.3. The Interface

You will find the employee list on the left side. Since previous versions of TimeClock Plus, this list has been enhanced to make finding an employee easier. In addition to an employee number, you can search by first name, last name, badge number, or export code using one of the fields at the top. Badge and Export Code are turned off by default, so to search by these, right click on the list, select **Show badge number** or **Show export code**, and scroll to the right.

When an employee is selected, the information and settings will appear on the right side of the screen (divided between tabs). There are several buttons at the bottom of each tab for managing employees. Among these, the following are the most important:

*A complete list of the buttons may be found in the User Reference Guide: Section 4.1.3. The Interface.*

**Save** – This button allows you to save a new employee/changes made to an existing employee. The **Save** button will save all of the changes for all the employee tabs in which information was entered or altered.

**Criteria** – This button allows you to filter the list of employees. For example, if you want to look at a certain employee or a group of employees then you can adjust the criteria to only show those people. If you want to look at a department or a group of departments then you can adjust the criteria to only show those departments.

2.0.4. Employee Information and Settings

For each employee, you may enter information (such as the employee’s name, address and phone number), assign job codes, configure settings (such as overtime settings, clock restrictions, and rounding), enter notes, store a photo, track reviews, and access archived data (such as raises and messages). All of this information has been organized under the various tabs. It is not required to complete each tab. However, when you create an employee, you must enter a first and last name, a hire date is recommended, and you must add at least one clockable job code so the employee can clock in and out. Below is a breakdown of the more important tabs.

*A complete list of the tabs and settings may be found in the User Reference Guide: Section 4.1.4. Employee Information and Settings.*
2.0.4.1. Info Tab

This tab stores personal information for an employee such as name, address, phone number, etc. The majority of this information is not required, but if you do not have this information stored in another application then we recommend that you enter and maintain it here.

Many of the fields under this tab track additional information including the hire date, termination date, class, department, export code, network ID, badge, pin, and a suspended option.

*Fields can be marked as “required” in the TimeClock Defaults (refer to 12.0.8. Employee Entry in the User Reference Guide found on the CD).*

First and Last (name) – The employee’s first and last name are required fields.

Hire Date – While this is an optional field, it is recommended that you enter the employee’s hire date as other features depend on it such as criteria and reviews.

2.0.4.2. Jobs Tab

This tab is used to add job codes and establish a default pay rate for the employee. At least one clockable job code must be assigned to the employee for him/her to start clocking in and out.

Rates do not have to be entered, but they may be entered if you choose to track the rate of pay. Rates will be reflected in many of the reports. There is also an option to enter a raise. All of the raises are then archived for future reference.

*For more information on rates and raises, please refer to 4.1.4.3. Jobs Tab in the User Reference Guide found on the CD.*

Adding a Job Code

1. Click **Add**.
2. Select a job code from the **Job Code** drop down list.
3. If you wish to override any of the default settings, adjust them (see the next sub-section), and click **OK**.

Editing a Job Code

1. Select a job code by placing a check next to it.
2. Click **Edit**.
3. Make any desired changes to the settings and click **OK**.

Deleting a Job Code

1. Select a job code by placing a check next to it.
2. Click **Delete**.

© Data Management, Inc. All Rights Reserved. This documentation may change without notice.
3. Click **OK** to confirm.

If a job code is no longer used, it is recommended that you deactivate it instead of deleting it in order to preserve the history of hours in that job code.

### 2.0.4.2.1. The Employee Job Code Settings

The settings that affect the employee when clocking into a job code are stored in the employee job code settings screen.

**After a job code has been assigned to an employee, any changes made in the Master Job Code List will affect employees who are later assigned that job code, but will not affect the employees who were already assigned that code. To change the settings of an assigned job code, you can select the employee in Add/Edit and edit the job code or globally modify the job code (Employee > Global modification).**

**Information Tab**

This tab is used to select a job code for the employee, to manage the rate of pay for the job code, and to adjust other settings such as the code being clockable or earning overtime.

**Job Code** – This drop down list contains every active job code in the Master Job Code List that has not been assigned to the employee. From here, select the job code you wish to assign.

**New** button – This button allows you to create a new job code without having to reference the Master Job Code List option.

**Use individual’s default rate of pay** – If this option is selected, the job code will use the employee’s default pay rate found in the previous screen (at the top of the Jobs tab).

**Specify rate for this job code** – If this option is selected, the job code will use the rate specified here.

**Code is active** – If this option is selected, the job code will be active for the employee. If un-checked, the job code will be inactive (not available for clock operations or when editing hours). The job code must also be active in the Master Job Code List.
Why would I want to make a job code inactive? When a job code is no longer needed, instead of deleting it (since there may be a history of use), it is recommended that the code be made inactive. This task may also be carried out globally (Employee menu > Global modification).

Code is clockable – If this option is selected (and if the code is active) the employee will be able to clock in/out using this job code via WebClock or a Remote Data Terminal. Managers will be able to add a shift to the employee using this job code. If this option is un-checked, the employee will not be able to clock in/out using this job code, but users will still be able to add a shift to the employee using this job code. Job codes that are commonly not clockable include Sick, Vacation, Holiday, etc.

Code counts toward overtime – This is option is selected when Code earns overtime is enabled. If Code earns overtime is un-checked, this option is checked, hours for this job code won’t earn overtime, but will count towards it. For example, if an employee is configured to reach overtime after 40 hours, works 32 hours in a job code that doesn’t earn, but does count toward overtime, and then works 10 hours in a job code that does earn, the employee will have 2 hours of overtime because the 32 hours earlier in the week counted toward overtime. If the employee worked 42 hours in a job code that doesn’t earn, but does count toward overtime, the employee will be paid 42 regular hours because it doesn’t earn overtime by itself.

Code earns overtime – If this option is selected, hours for this job code can earn overtime. For example, if an employee is configured (Add/Edit > Overtime tab) to reach overtime after 40 hours then all hours worked over 40 will be considered overtime.

Code is default for individual – If this option is selected, when an employee is prompted to select a job code, this job code will be highlighted by default. This can only be enabled for one job code per employee.

Force overtime 1 for this job code – If enabled then every minute worked in this code will be treated as overtime 1.

Force overtime 2 for this job code – If enabled then every minute worked in this code will be treated as overtime 2.

Auto transfer job code hours from schedule during close week – This is not available in TimeClock Plus OnDemand (Basic).

Allow the use of this code for client time sheet entry – This is not available in TimeClock Plus OnDemand (Basic).
This tab is used to designate the overtime rules for the employee (how overtime is calculated). This option is not affected by your company’s pay frequency. For example, you may pay all employees weekly overtime on a semi-monthly pay frequency.

TimeClock Plus allows for the calculation of two overtime types (e.g., you may pay time and a half for hours worked between 40 and 60 and double-time for hours above 60).

Overtime Calculations - From the drop-down list, select the method used to calculate overtime for this employee.

- **Weekly Overtime** – Overtime is based on X hours a week.
- **Daily Overtime** – Overtime is based on X hours a day.
- **Best of Weekly vs. Daily** – The system will calculate overtime on a daily and weekly basis for the employee. Overtime will be based on the higher of the two overtimes.
- **Bi-Weekly Overtime** – Overtime is based on X hours in a 14-day work period.
- **Best of Bi-Weekly vs. Daily** – The system will calculate overtime on a daily and bi-weekly basis. Overtime will be based on the higher of the two overtimes.
- **Salaried** – No overtime will be calculated. However, If this option is selected, an option will become available below to enter the salaried amount per year. This amount may be used in calculating estimated labor cost.
- **Both Daily and Weekly Overtime** – The system will calculate overtime on a daily and weekly basis for employees. Total overtime will be a sum of daily overtime plus weekly overtime. With this method, daily overtime is calculated first and then regular hours are calculated to determine weekly overtime.
- **Both Daily and Bi-Weekly** – The system will calculate overtime on a daily and biweekly basis for employees. Total overtime will be a sum of daily
overtime plus weekly overtime. With this method, daily overtime is calculated first and then regular hours are calculated to determine weekly overtime.

- **Both Daily and Weekly (2)** – The system will calculate overtime on a daily and weekly basis for employees. Total overtime will be a sum of daily overtime plus weekly overtime. With this method, daily overtime is calculated first and then all hours are re-calculated to determine weekly overtime. The weekly and daily overtimes are merged to obtain the calculations for the period.

- **Both Daily and Bi-Weekly (2)** – The system will calculate overtime on a daily and biweekly basis for employees. Total overtime will be a sum of daily overtime plus weekly overtime. With this method, daily overtime is calculated first and then all hours are re-calculated to determine weekly overtime. The weekly and daily overtimes are merged to obtain the calculations for the period.

**Individual also earns a salaried amount** – If checked, you can enter a salaried figure along with overtime. This amount may be used in calculating estimated labor costs.

**Ignore regular hours for this individual** – If this option is selected, only overtime hours will be reflected in the reports and exports.

**Overtime Multipliers** – In these fields, enter the multipliers used to calculate overtime. If overtime 1 is time-and-a-half then enter 1.5 in the overtime #1 field and if overtime 2 is double-time then enter 2.0 in the overtime #2 field.

**Overtime Settings** – In these fields, enter the number of hours an employee must work to qualify for overtime. The fields that appear in this section will change as you select different methods in the Overtime Calculations drop-down list.

**Note!** Use Default Information is not available in TimeClock Plus OnDemand (Basic).
2.1. Removing Employees

From time-to-time a company will need to remove an employee from the system. Sometimes this removal is not permanent. For example, the employee may be a seasonal worker, returning each summer, and it would benefit the company to keep his/her employee data in the system and just reactivate the employee when they return to work.

Even in cases where an employee will not be returning, a company may want to retain historical information about the employee (so that hours and other information are available via reports). TimeClock Plus offers three options for the temporary or permanent removal of an employee from the system - suspension, termination or deletion.

We recommend that you suspend or terminate an employee instead of deleting. If you suspend or terminate them, the criteria, by default, will exclude them from lists and reports. If you delete an employee, it will remove all current and historical information from the system permanently.

2.1.1. Suspending

SUSPENDING AN EMPLOYEE IS RECOMMENDED TO PRESERVE THE EMPLOYEE’S HISTORICAL DATA. BY SUSPENDING AN EMPLOYEE, HE/SHE WILL NO LONGER BE ABLE TO CLOCK IN OR OUT, THEIR HISTORICAL DATA WILL REMAIN IN THE DATABASE FOR REPORTING AND RESEARCH PURPOSES, AND THE DEFAULT CRITERIA EXCLUDES ALL “SUSPENDED” EMPLOYEES FROM LISTS, REPORTS, ETC.

Suspending an Employee

1. In WebManager, go to Employee > Add/Edit.
2. Double click on an employee in the list on the left (or enter the ID and press Enter).
3. Under the Info tab, place a check next to Individual is suspended.
4. Click Save.

Un-suspending an Employee

1. In WebManager, go to Employee > Add/Edit.
2. Click Criteria.
3. Remove the check next to Exclude suspended individuals and click OK.
4. Double click on an employee in the list on the left (or enter the ID and press Enter).
5. Under the Info tab, remove the check next to Individual is suspended.
6. Click Save.
2.1.2. Terminating

Termination is similar to suspension. Once the employee is set to a terminated state, they will no longer be able to clock in or out, their historical data will remain in the database for reporting purposes, and the default criteria excludes all “terminated” employees from lists, reports, etc.

Terminating an Employee

1. In WebManager, go to Employee > Add/Edit.
2. Double click on an employee in the list on the left (or enter the ID and press Enter).
3. Under the Info tab, enter a date in the Termination field.
4. Click Save.

Removing the Termination

1. In WebManager, go to Employee > Add/Edit.
2. Click Criteria.
3. Remove the check next to Exclude terminated individuals and click OK.
4. Double click on an employee in the list on the left (or enter the ID and press Enter).
5. Under the Info tab, remove the date from the Termination field.
6. Click Save.

2.1.3. Deleting

Deleting an employee from the TimeClock system permanently removes all of their work history and personal information from the database. This should only be used if the employee’s data will not be needed for any reason, now or in the future.

1. In WebManager, go to Employee > Delete.
2. Select the employee/employees you wish to delete.

THE NEXT STEP WILL REMOVE ALL DATA FOR THIS EMPLOYEE AND IT WILL NOT BE POSSIBLE TO UNDO THIS!

3. Click Process.
4. Click OK to confirm.

© Data Management, Inc. All Rights Reserved. This documentation may change without notice.

Rev. 2/21/11
SECTION III: MANAGING EMPLOYEE HOURS

The ability to add or edit shifts is essential in TimeClock Plus. Edit Hours is the only section that allows the user to change or delete records. From the Edit Hours screen, a user can add or edit time on an individual basis, add time for non-clockable job codes (sick, vacation, etc.), and correct inaccurate or incomplete clock operations.

3.0. Edit Hours

3.0.1. Adding a Record

1. In WebManager, go to the Employee menu > Edit hours.
2. Double click on an employee in the list on the left (or enter the ID and press Enter).
3. Press the Shift button at the bottom of the Edit Hours screen and select Add segment from the menu.
4. To add a complete record, enter the date in, time in, date out, and time out. The dates will be today’s date by default and the times will be the default times defined in the “Edit Hours Options”. These dates and times may be adjusted to the record you are adding.
5. If you are adding a shift in which the employee is already clocked in, place a check next to “Individual is clocked in” option and enter the Date In and Time In.
6. Select the job code.
7. If there was a break after this shift then select the break type.
8. Click OK.

For a breakdown of the other options, please refer to 5.0.3. The Edit Segment Window in the User Reference Guide found on the CD.
3.0.2. Editing a Record

1. Double click on an employee in the list on the left (or enter the ID and press Enter).

   The list of employees may be sorted in ascending or descending order by any of the columns. Columns may be enabled or disabled by right clicking on the list of employees and choosing a column. The available columns include the employee number, first name, last name, export code, badge number, and classification.

2. Double click on the record or highlight it, click the **Shift** button, and select **Edit segment**.
3. Make your desired changes and click **OK**.

For a breakdown of this window, refer to 3.0.3. The Edit Segment Window.

3.0.3. The Edit Segment Window

**Segment Tab**

**Date In** – This is the date when the shift started.

**Time In** – This is the time when the shift started.

**Date Out** – This is the date when the shift ended.

**Time Out** – This is the time when the shift ended.

**Job Code** – This is the job code for the shift.

**Rate** – This is the rate for the job code selected.

**Track1**, **Track2**, and **Track3** – These are the three available tracked fields. Examples of tracked fields include “tips” for a restaurant or “pieces” for a production environment.

   *If you choose to use any of these then they must be enabled (Employee > Add/Edit > select the employee > Jobs tab > edit the job code > Tracked Fields tab.*

**Break Type** – This is the break type that follows the shift. Leave the **None** option selected if a break doesn’t follow the shift you are adding.

**Note** – This field is used to enter a shift note for the shift you are adding.
Individual is clocked in – If this option is selected the Date Out and Time Out will not be required and the employee will remain clocked in.

Time sheet entry – This is not available in TimeClock Plus OnDemand (Basic).

Missed in punch – If selected, the Time In for the shift will appear as a missed in. When missed punches are enabled, the system will flag it automatically, but this option is available if it ever becomes necessary to add/remove a missed flag.

Missed out punch – If selected, the Time Out for the shift will appear as a missed out. When missed punches are enabled, the system will flag it automatically, but this option is available if it ever becomes necessary to add/remove a missed flag.

Extra Tab

Entry location – The source of this shift (where it was created/being created) will appear here.

Disable automatic deduction – If there was an automatic break deduction, then you may place a check here to disable it.

Disable segment minimum – If there was a segment minimum (depending on the segment minimum settings for the job code) then you may place a check here to disable it.

Force overtime 1 for this segment – If selected, hours in this code will be filed as overtime 1.

Force overtime 2 for this segment – If selected, hours in this code will be filed as overtime 2.

Other Information – Additional information about the shift will appear here.

3.0.4. Deleting a Record

1. Double click on an employee in the list on the left (or enter the ID and press Enter).
2. Select the record you choose to delete. You may select more than one with the Ctrl key.
3. Click on the Shift button and select Delete segment(s).

3.0.5. The Interface

The display areas for shifts worked will automatically display data for the current week, but previous weeks may be accessed via the History button.

Once selected, the employee’s hours will display in the shift window on the upper right portion of the screen. Each record includes several self-explained fields such as the time in, time out, and job code.

The Accrual Information and Schedule Information areas will not be used in TimeClock Plus OnDemand (Basic).
There are several buttons at the bottom for managing hours. Among these, the following buttons are the most important:

**Criteria** – This button allows you to filter the list of employees. For example, if you want to look at a certain employee or a group of employees then you can adjust the criteria to only show those employees. If you want to look at a department or a group of departments then you can adjust the criteria to only show those departments.

**Shift** – The Shift button opens a menu with several actions that are broken down in the next section.

**History** – This button allows you to access hours in previous weeks.

For more information on the interface including the following columns: O, M, I, Note, Edited, and B, please refer to 5.0.6. The Interface in the User Reference Guide found on the CD.

### 3.0.6. Shift Menu Options

When clicking on the Shift button or right clicking in the hours panel (upper right panel), there will be several options. The more important options are mentioned here.

A complete list of the options may be found in the User Reference Guide found on the CD: 5.0.7. Shift Menu Options.

**Add segment** – This option allows you to add a record. It will only be available when an employee is selected.

**Edit segment** – This option allows you to edit a record. It will only be available when a record is highlighted.

**Delete segment(s)** – This option allows you to delete a record. By default, you will be asked to confirm whether or not you want to delete the selected record.

You may disable the Delete Confirmation (Options button > Display tab > Ask for confirmation when deleting a shift from an individual).

**Approve missed in punch** – This option allows you to approve a missed time in punch. If the punch was missed, it will appear in blue. Once approved, it will display in green text. This option will only be available when a record with an unapproved missed time in is highlighted. If the missed punch reads: "<< Missed >>" then you won’t be able to approve it until you edit the record and enter a time.

**Approve missed out punch** – This option allows you to approve a missed time out punch. If the time out was missed then it will appear in blue. Once approved, it will display in green text. This option will only be available when a record with an unapproved missed time in is highlighted. If the missed punch reads: "<< Missed >>" then you won’t be able to approve it until you edit the record and enter a time.
SECTION IV: CLOSING THE WEEK

The current week in TimeClock Plus must be updated on a regular basis by closing the week (every week, every two weeks, etc.). You are not required to close the week as soon as the week has ended. The system can maintain multiple weeks of data, however, there is a limit: the current week in TimeClock Plus must be within 56 days (8 weeks) of today’s date.

This is the most important operation in the system because it acts as a trigger for the following processes:

- Hours are archived (moved to history)
- Cumulative totals for each employee are updated

You can still access and edit hours in a week that was closed.

At the bottom of WebManager, notice the two dates. The first is today’s date and the second is the current week in TimeClock Plus. In the example below, today’s date (far bottom right corner) is 3/16/2010, but the current week (blue rectangle) is 3/7 (last week). Today’s date falls in the week of 3/14, so the week should be closed.

![WebManager screenshot showing dates and week selection]

4.0. Closing the Week

The close week will be aborted if certain conditions exist. Before closing the week:

- Verify that no one is clocked in (Tools > Who’s Here > Clock in tab).
- If employees are configured to require hour approvals, ensure that all hours have been approved (Employee > Approval Manager).
- If missed punches are enabled, verify that any missed punches have been approved (Employee > Missed Punctures).

![Warning icon]

Do not close the week you are in until the week ends. Otherwise employees will be unable to clock in and out and users will be unable to add time. If you do close this week by accident then there is an option to un-close the week.

1. In WebManager, go to File > Close current week.

© Data Management, Inc. All Rights Reserved. This documentation may change without notice.
2. There will be a warning message that asks you to confirm the close.

   If multiple weeks are open, please repeat the close week process until the current week is up to date.

4.1. Un-closing the Week

If you accidentally close the wrong week then this option allows you to re-open that week.

When you un-close, the Current Week will be adjusted back to the week before it.

1. In WebManager, go to File > Undo close week. There will be a warning message that asks you to confirm.
2. The week you will return to after you unclose the week will appear in the warning. If you wish to return to that week then click Yes.
SECTION V: MANAGER REPORTS

5.0. Payroll Reports

TimeClock Plus OnDemand (Basic) offers some reports that reflect hours on an employee basis in either a detailed breakdown or summary and a report that reflects missed punches.

Configurable

The reports may be configured to include or exclude different pieces of information. These settings may be configured per user thus allowing users to view the same report differently (in a format to their preference).

5.0.1. Generating a Report

1. In WebManager, go to Period > Reports.

2. Enter the date range for the report. Instead of entering the dates manually, you can choose a range from the drop down list.

3. Place a check next to the report you wish to view or print.

4. To choose which employees should be included in the report, click Criteria, choose a filter, configure it, and click OK. If you want to include everyone then skip the criteria.

5. To view or print the report, click Print, and choose from the list of available outputs.
   - Print to file – This will save the selected report(s) to a TCRPT file which can be opened outside of WebManager using TimeClock Plus’ Report Printer.
   - Print to PDF – This will save the selected report(s) to a PDF for viewing in Acrobat Reader.
   - Print to HTML – This will save the selected report(s) to HTML for viewing in a web browser.
   - Print to Office OpenXML – This will save the selected report(s) to the OpenXML format for viewing in Microsoft Excel or other spreadsheet applications.
   - Print to E-Mail – This will save the selected report(s) to a PDF and...
attach them to an E-Mail inside of WebManager.

The E-mail option will only be available when the following conditions exist: 1) you are not logged in as supervisor, 2) your user has an E-mail address on file (refer to 12.2.3.1. Information Tab in the User Reference Guide), and 3) the mail settings have been defined in the TimeClock Defaults (refer to 12.0.6. Mail Settings in the User Reference Guide).

5.0.2. Configuring a Report

1. In WebManager, go to Period > Reports.
2. Place a check next to the report you wish to configure.
3. Click Settings.
4. You may change the report title or make changes to the settings (the settings will differ for each report).
5. Click OK.

5.0.3. Saving a Report

This feature is not available in TimeClock Plus OnDemand (Basic).
SECTION VI: CRITERIA

Because companies often have the need to perform certain operations for a selected group of employees (for example, by physical location or for one department), TimeClock Plus provides the ability to filter employees when performing several processes in the system. Employee lists throughout the system and reports display information based on criteria.

Some examples of processes that utilize criteria are:

- Running a Report
- Globally Adding or Removing a Job Code to and from Employees
- Viewing Employee Lists (when editing employee information or hours)

All processes that can be filtered feature a Criteria button that will open the following screen.

Filtering can be performed based on one field or a combination of the standard fields and custom fields that are presented in the Criteria options as follows:

**Filter by individual’s number** – if this option is selected, this field allows you to “include” or “exclude” a single individual or range of individuals by their employee number.

**Filter by classification to** – if this option is selected, this field allows you to “include” or “exclude” individuals by a single classification code or range of classification codes.

**Filter on default job to** – if this option is selected, this field allows you to “include” or “exclude” individuals by a single default job code or range of default job codes.

*Note:* Some employees may not have a default job code designated in Add/Edit (Jobs tab).

© Data Management, Inc. All Rights Reserved. This documentation may change without notice.
Filter on department – this option allows you to include employees that are part of a particular department. The button found to the right of the field can be clicked to display different options that can assist in locating the department name quickly.

Filter on individual's manager to include – if this option is selected, this field allows you to include employees that have a specific manager assigned to them.

Filter on hire date to include from – this option allows you to include employees hired between specific dates.

Filter on days since hire to include from – this option allows you to include employees based on the number of days since their hire date (a single day or range of days since date of hire).

Exclude suspended individuals – if this option is selected, all employees that have been suspended will not be included in the results. This box is checked by default.

Exclude terminated individuals – if option is selected, all employees that have been terminated will not be included in the results.

Exclude salaried individuals – if option is selected, all employees that utilize the “Salaried” overtime calculation category will be excluded from the results.

Custom fields – This is not available in TimeClock Plus OnDemand (Basic).
SECTION VII: TOOLS IN WEBMANAGER

There are some tools available to monitor employee activity, hour totals (overtime), and access logs (hour edits and overrides). In this guide, we will cover a few tools for viewing employee activity, fixing clock operations and monitoring hour totals.

7.0. Who’s Here

The Who’s Here section is used for monitoring employee activity in real-time. It allows managers to immediately know the status of each employee and, from certain tabs, clock an employee out, put an employee on break, or move the employee to a different job code.

All
This tab lists all of the employees clocked in or otherwise. It includes their status and, if clocked in, their shift information. From here, the manager may clock an employee out, put an employee on break, move an employee to a different job code, or add a shift note to an employee.

Clocked In
This tab lists all of the employees who are clocked in. From here, the manager may clock an employee out, put an employee on break, move an employee to a different job code, or add a shift note to an employee’s shift.

On Break
This tab lists all of the employees who are on a break.

Auto Out
This tab lists all of the employees who have been automatically clocked out (if Auto Out was enabled for their job code). These employees could be considered “on the clock”, but a time out has already been entered automatically for their shift. They will appear under this tab, to let you know they are working, until the time out that was entered has passed (to determine the time out, right click on the record > Shift info).

Not In
This tab lists all of the employees who are not clocked in.

Last Punch
This tab lists each employee’s status, last clock in, and last clock out.

Hours
This tab is similar to the Call List as it lists the total hours worked by each employee for the day and for the week. The employee’s last clock out, hire date, and status will also appear here.

Leave
This tab lists all of the employees who are currently clocked into a leave code (e.g., employees who are sick or on vacation right now). They will appear under this tab until the time out of their leave record has passed.
The Absent button is not available in TimeClock Plus OnDemand (Basic).

1. In WebManager, go to Tools > Who’s here.

2. Choose a tab that includes the information you choose to review. See the breakdown of tabs before these steps for more information.

3. Each tab may be sorted by any of its columns if you click on the column header.

4. To choose which job codes should be included in the list, right click on the list, and select Filter by job code. Select the job codes you choose to include and click OK. This setting will apply to all of the tabs until you right click again and select Cancel job code filter.

5. To choose which employees should be included in the list, click Criteria, choose a filter, configure it, and click OK. If you want to include everyone then skip the criteria.

6. To jump to an employee in the list, enter the first name or last name next to Find. It will highlight the closest match to what is entered as you enter it.

7. To view that employee’s hours, right click on him/her, and select Edit hours.

8. To print this list, choose one of the outputs in the top right corner (from left to right: .xls in Microsoft Excel, document in Microsoft Word, or .csv in Microsoft Excel).

If minor tracking has been enabled in the TimeClock Defaults (Configuration > Preferences > Defaults > Manager Settings > Minor Tracking) then any minor who is working past the time entered in the Minor Tracking section of the Defaults will appear in red.

Shifts that exceed 8 hours will appear in green and shifts that exceed 12 hours will appear in blue. The amounts to flag (8 and 12) and the color (blue and green) may be changed in the Who’s Here Options.

7.0.1. Putting an Employee on Break

1. From the All, Clocked In, Last Punch, or Hours tab, select an employee who is clocked in, right click, and click Clock Out.
2. For **Date Out**, enter the date of the break.
3. For **Time Out**, enter the time that the break began.
4. Choose the **Break type**.
5. If tracked fields are enabled for the employee’s job code and are required when clocking out, you can enable the tracked fields and enter an amount.
6. Click **OK**.

### 7.0.2. Clocking an Employee Out

1. From the **All**, **Clocked In**, **Last Punch**, or **Hours** tab, select an employee who is clocked in, right click, and click **Clock Out**.

2. For **Date Out**, enter the date of the clock out.
3. For **Time Out**, enter the time of the clock out.
4. The **Break type** should remain **<< None >>**.
5. If tracked fields are enabled for the employee’s job code and are required when clocking out, you can enable the tracked fields and enter an amount.
6. Click **OK**.

### 7.0.3. Moving an Employee to a Different Job Code

1. From the **All**, **Clocked In**, **Last Punch**, or **Hours** tab, select an employee who is clocked in, right click, and click **Change job code**.

2. For **Change date**, enter the date when the employee should change job codes.
3. For **Change time**, enter the time when the employee should change job codes.
4. Select the **Job Code** that the employee should be changed to.
5. If tracked fields are enabled for the employee’s job code and are required when clocking out, you can enable the tracked fields and enter an amount.
6. Click **OK**.
7.1. Call List

The Call List is a list of each employee’s total hours for today and this week to help you avoid overtime, to assist you with making staffing decisions, and to call in replacements on an individual basis or for a new shift. Call List notes may also be entered with an expiration date and time. Each employee’s hire date, phone number, and cell phone number is also provided (if entered in Add/Edit) and employees, who have entered overtime, will be flagged in red.

1. In WebManager, go to Tools > Call list. The Call List screen will display employees with their hours worked to date.
2. To choose which employees should be included in the list, click Criteria, choose a filter, configure it, and click OK. If you want to include everyone then skip the criteria.
3. To print this list, choose one of the outputs in the bottom right corner (from left to right: .xls in Microsoft Excel, document in Microsoft Word, or .csv in Microsoft Excel).

Adding a Call List Note

In previous versions, the Call List notes would automatically expire after 4 hours. Now the date and time of expiration is up to you.

1. Right click on the record or highlight it and select Add Note.
2. Enter a note.
3. Next to Expiration, enter the date and time that the note should expire.
4. Click OK.
SECTION VIII: COMPANY-WIDE CONFIGURATION

8.0. TimeClock Defaults

This section addresses additional settings that will impact your use of the system going forward.

There are entire tabs even that do not apply to TimeClock Plus OnDemand (Basic). They are, however, available in TimeClock Plus OnDemand (Premium). The tabs not available to OnDemand:

- Reminder Bar
- Accruals
- Miscellaneous (under Scheduler Settings)
- Request Entry

There are also tabs that contain some settings that apply and some that do not. The settings that do not apply:

- Close Week tab: Automatically copy schedules forward when closing the week

In WebManager, go to Configuration > Preferences > Defaults.

There are four sections of settings:

1. Global Settings
2. Manager Settings
3. Scheduler Settings: Not available in TimeClock Plus OnDemand (Basic)
4. Client Settings (applicable to WebClock and the Remote Data Terminal)

Some important settings within these sections include:

- **Display Settings**: The company name and the commonly mentioned elements of TimeClock Plus (employees and job codes) may be renamed here. Also, if you are using tracked fields, they may be renamed and configured (decimal places) here.
- **Breaks**: The four available break types may be set up here (by default there is only one break type, but you may rename that break and enter up to three more). Also the maximum break length may be changed here (if an employee goes on a break and exceeds this amount then the break will be changed to a clock out).
- **Client Settings > Miscellaneous**: The functions available to your employees during a clock operation may be determined here.
- **Missed Punches**: The method of managing missed punches may be chosen here.

Two of the sections above are covered in this guide. All of the categories may be found in the User Reference Guide: Section 12.0. TimeClock Defaults.
8.0.1. Miscellaneous (under Client Settings)

This section includes settings that affect the employee in WebClock or a Remote Data Terminal (e.g., which employee self-service options should be available) such as viewing or approving hours and missed punches.

**Allow employee to change his/her pin number** – If this option is selected, employees will be able to change their pin from the confirmation screen. The confirmation screen appears in WebClock during a clock operation or after clicking the View button and logging in.

**Allow employee to set a blank pin number** – If this option is selected, employees will be able to set a blank pin. The option: **Allow employee to change his/her pin number** must be checked for this option to be available.

**Allow viewing of hours worked** – If this option is selected, employees will be able to view their hours worked for the week to date from WebClock or a Remote Data Terminal.

**Allow approving of punches (on-screen only)** – If this option is selected, employees will be able to approve their time when viewing their hours from WebClock.

**Allow printing of hours from view screen (on-screen only)** – If this option is selected, employees will be able to print their displayed hours worked when viewing from WebClock.

**Allow viewing of previously entered shift notes (on-screen only)** – If this option is selected, employees will be able to view shift notes that they entered when viewing their hours from WebClock.

**Allow entering of shift notes (on-screen only)** – If this option is selected, employees will be able to enter notes for a particular shift when clocking in/out via WebClock.

**Allow viewing of accruals (up to current week)** – This is not available in TimeClock Plus OnDemand (Basic).

**Allow viewing of schedules for up to how many weeks** – This is not available in TimeClock Plus OnDemand (Basic).
**Allow viewing of last punch** – If this option is selected, employees will be able to view their last clock operation from WebClock or a Remote Data Terminal.

**Allow the use of the break button** – If this option is selected, the Break button will be viewable in WebClock and functional on the remote data terminal. For WebClock, the Break button must be enabled (*WebClock Configuration > Windows Layout tab > Display break button*).

**Allow change job code option** – The button for changing job codes will be enabled and active in WebClock or a Remote Data Terminal.

**Allow editing of hours from the employee access terminal (by pressing 6 at the main menu)** – This option allows users to edit employee hours from the terminal by pressing the number 6 on the keypad.

**Show employee’s id number when performing an operation** – The employee’s number will display as they enter it to clock in/out of the system. If this option is not enabled, asterisks will mask the numbers on the keypad as the id is entered.

**Prevent clock in if a conflicting shift segments exists** – If this option is selected, employees will not be allowed to clock in if there is a conflicting shift.

**Only perform “round to minute” if not already rounded to schedule** – If checked, the system will not perform both rounding to schedule and rounding to minute.

**Auto select default job code when returning from a break (if configured for employee)** – If selected the employees default job code will be used when they clock back in from a break. This requires that “Always use default job code when clocking in” is enabled for the employee (*Employee > Add/Edit > select employee > Misc tab*).

**On-Screen Time Sheet Entry** – The settings in this section are not available in TimeClock Plus OnDemand (Basic).
8.0.2. Missed Punches

This section allows you to setup missed punches.

**Missed In Punch**

If an individual attempts to clock out without an associated in punch, what action should be taken (select one of these four options):

- **Deny clock out until the punch is corrected** – When the employee forgets to clock in and tries to clock out, the operation will be denied until the missed time is edited.
- **Record blank time in and flag as a missed punch** – When the employee forgets to clock in and tries to clock out, the system will record the missing time in as <<Missed>> and allow the employee to clock out. At some point, the “missed in” will need to be corrected by a manager and approved.
- **Record scheduled time in (if available) and flag as a missed punch** – This is not available in TimeClock Plus OnDemand (Basic).
- **Allow individual to enter the time in and flag it as a missed punch** – When the employee forgets to clock in and tries to clock out, the employee will be allowed to enter the time of the missed punch. Eventually a manager will need to approve it.

**Missed Out Punch**

If an individual attempts to clock in when they are already clocked in, what action should be taken (select one of these four options):

- **Deny clock in until the punch is corrected** – When the employee forgets to clock out and tries to clock in, the operation will be denied until the missed time is edited.
- **Record blank time out and flag as a missed punch** – When the employee forgets to clock out and tries to clock in, the system will record the missing time out as <<Missed>> and allow the employee to clock in. At some point, the “missed out” will need to be corrected by a manager and approved.
- **Record scheduled time out (if available) and flag as a missed punch** – This is not available in TimeClock Plus OnDemand (Basic).
- **Allow individual to enter the time out and flag it as a missed punch** – When the employee forgets to clock out and tries to clock in, the employee will be allowed to enter the time of the missed punch. Eventually a manager will need to approve it.

© Data Management, Inc. All Rights Reserved. This documentation may change without notice.
SECTION IX: CONFIGURING WEBCLOCK

WebClock may be configured to look and behave differently for certain employees. For example, a company may want to remove the Clock In and Clock Out buttons from their salaried employees and enable the View button. By default, everyone will use the Default configuration, but additional configurations may be created and assigned.

9.0. Changing the Configuration

1. Open a supported web browser such as Internet Explorer.
2. Go to the URL of WebClock.
3. Click Configuration.
4. Select the company if more than one company exists.
5. Enter the User Id and Password.
6. Click Login.
7. Click Configure Settings.

More than one configuration may be created. For more information, refer to 18.6.2. Creating a New Configuration and 18.8. Assigning Configurations in the User Reference Guide.

8. Highlight the Default configuration and click Select. Every employee’s WebClock will use the Default configuration unless they are assigned to a different configuration.

It is recommended that you configure the default settings for most of your clients and assign specific configurations to the employees who need unique settings.

9. Make the desired changes (refer to 18.7. WebClock Settings in the User Reference Guide) and click OK.
10. Click Logout to close the WebClock configuration.
HARDWARE

1.0. Using a Terminal

The Remote Data Terminal (RDT) allows employees to clock in and out without a computer. It collects punches and communicates those back to the TimeClock Plus database.

When entering the employee number, step 3 in the following lists of steps will only be necessary if the option: Show confirmation screen on manual entry is enabled in WinRemote. When swiping a card, step 3 will only be necessary if the option: Show confirmation screen on non-manual entry is enabled in WinRemote.

1.0.1. Clocking In

1. Press Clock In.
2. Enter your employee number and press Yes/Enter or swipe your card.

If swiping a card, swipe with the magnetic strip or bar code facing right.

3. Press Yes/Enter if prompted to confirm your identity.

- If more than one clockable job code has been assigned to the employee then the job code will need to be selected and if a tracked field is required then an amount will need to be entered.
- If a restriction exists then a manager may override it with his/her Remote Data Terminal - Override password.
- If the terminal has a magnetic/bar code reader then a card can be encoded with the override password and the manager can swipe the card when asked for the password (more secure than entering the password in front of the employee).
1.0.2. Clocking Out

1. Press **Clock Out**.
2. Enter your employee number and press **Yes/Enter** or swipe your card.
3. Press **Yes/Enter** if prompted to confirm your identity.

- If a clock restriction exists then a manager will need to override it with his/her **Remote Data Terminal - Override** password.
- If a tracked field is required then an amount will need to be entered.

1.0.3. Clocking Out for a Break

1. Press **Start Break**.
2. Enter your employee number and press **Yes/Enter** or swipe your card.
3. Press **Yes/Enter** if prompted to confirm your identity.

*Note!* There is one break type by default. However, more than one break type may be created in TimeClock Manager (**Configuration > Preferences > Defaults > System Wide Settings > Breaks**). After pressing **Start Break**, if prompted, choose the correct break type.

If a tracked field is required then an amount will need to entered.

1.0.4. Changing Job Codes

1. Press **Job Code**.
2. Enter your employee number and press **Yes/Enter** or swipe your card.
3. Press **Yes/Enter** if prompted to confirm your identity.
4. Select the new job code and press **Yes/Enter**.

*Note!* If a tracked field is required then an amount will need to entered.
1.0.5. Changing Cost Codes (Requires Job Costing Module)

If the Job Costing module is installed, loaded, and enabled for the employee and that employee is clocked into a job code that requires a cost code then the employee may change cost codes.

2. Enter your employee number and press Yes/Enter or swipe your card.
3. Press Yes/Enter if prompted to confirm your identity.
4. Select the new cost code using the Clock In and Clock Out keys to move through the list, and press Yes/Enter to select each level.

1.0.6. Viewing Hours

Employees may view their hours in the current week on the terminal if the option to Allow viewing of hours worked is enabled in TimeClock Manager (Configuration > Preferences > Defaults > TimeClock Client > Access).

If the option to Allow viewing of hours worked is checked or unchecked in TimeClock Manager then the port or ports will need to be stopped and restarted in WinRemote.

1. Press View and then the number 1 to view hours worked.
2. Enter your employee number and press Yes/Enter or swipe your card.
3. Press 0 for detail on the shift or press No/Esc to return to the main screen.

Managers may edit hours on the terminal if the option to Allow editing of hours from the employee access terminal is enabled in TimeClock Manager (Configuration > Preferences > Defaults > Client Settings > Miscellaneous). The manager must have a user account with rights to edit hours from the terminal (Configuration > User list).

1.0.7. Viewing the Last Punch

Employees may view their last punch on the terminal if the option to Allow viewing of last punch is enabled in TimeClock Manager (Configuration > Preferences > Defaults > Client Settings > Miscellaneous). The option to Show confirmation screen on manual entry or, if using a card, the option to Show confirmation screen on non-manual entry must also be enabled in the WinRemote application.

If you enabled/disabled the option to Allow viewing of last punch in TimeClock Manager then the port or ports will need to be stopped and started again.

1. Press Clock In or Clock Out. Viewing the last punch does not require a clock operation, but to access the screen that shows the last punch, the Clock In or Clock Out buttons must be pressed.
2. Enter your employee number and press Yes/Enter or swipe your card.

© Data Management, Inc. All Rights Reserved. This documentation may change without notice.

Rev. 2/18/11
3. When your name is displayed on the screen with the Y/N confirmation, press 8 on the keypad and then press No/Esc to return to the main screen.

1.0.8. Viewing Schedules

Employees may view their schedule for the current week and the next week on the terminal if the option to Allow viewing of schedules is enabled in TimeClock Manager (Configuration > Preferences > Defaults > Client Settings > Miscellaneous).

1. Press View and then the number 2 to view hours scheduled.
2. Enter your employee number and press Yes/Enter or swipe your card.
3. If prompted, select this week or next week, and press Yes/Enter.
4. Press Clock In or Clock Out to move through the schedules and then press No/Esc to return to the main screen.

1.0.9. Viewing Accruals

Employees may view their accruals up to the beginning of the current week on the terminal if the option to Allow viewing of accruals (up to current week) is enabled in TimeClock Manager (Configuration > Preferences > Defaults > Client Settings > Access).

1. Press View and then the number 3 to view hours accrued.
2. Enter your employee number and press Yes/Enter or swipe your card.
3. Press a key after the warning. The warning, although the date will vary, should read: “Information accurate to 12/15/2007. Press a key.”
4. Press Yes/Enter to move between the job codes that accrue time and then press No/Esc to return to the main screen.
1.1. Ethernet Terminal

Product Components

- Terminal
- Wall-Mount
- Power Pack
- Ethernet Cable
- Barrel Keys

1.1.1. Wall Mount Installation

Location and Position

1. Locate wall-mount on smooth surface at a minimum height of 46” off the floor.

Mounting Holes

2. Align a bubble level with the top edge of the wall mount and gently rotate the mount until the bubble level shows that the top edge of the mount is level.
3. Using the mount as a template, mark the locations of the mount holes.
4. Remove mount and drills holes with appropriate hardware based on wall material.

Secure to Wall

5. Re-position wall-mount and fasten securely to wall.

1.1.2. Terminal Installation

Connection of Communications and Power

1. Connect power pack to the terminal’s Power In port.
2. Connect one end of the Ethernet cable to the terminal’s Ethernet port.
3. Connect the other end of the Ethernet cable to the Ethernet port on your network device.
Hang and Secure Terminal

4. Place terminal over the wall-mount, making sure to route the power and Ethernet cable through the access hole at bottom or back of the mounting plate.
5. Hook terminal onto top hanger tabs. This will align the terminal on the wall-mount. Rotate bottom in while sliding upward until terminal drops into hanger tabs.
6. Slide the terminal down and close it. Be careful to not crush any electronic components within the terminal by forcing it closed. You may have to check for cable clearances within the terminal.
7. Secure terminal to wall mount with the barrel lock at the bottom.

1.1.3. Configuring a Series 100/200 Ethernet Terminal

1. To configure the terminal, power it on and press F1 when the display reads “F1 for setup...” If the terminal is displaying “Waiting for Host” then it has already completed the boot process. Reset the power to the terminal and press F1 when prompted.
2. This will enter the “Terminal Setup” menu. Press the down arrow (F2) to select “Ethernet” and then press Yes/Enter to confirm the selection.
3. The terminal will then display the “Ethernet Settings” menu. Press Yes/Enter to select “IP Address.”
4. The terminal will display its current network configuration. Enter the IP address of the terminal and press Yes/Enter. This IP address must be accessible by the computer that will be running the WinRemote software. Please contact your network administrator if you are unfamiliar with configuring a network device.
5. Enter the subnet mask into the field labeled SM and press Yes/Enter.
6. Enter the default gateway into the field labeled GW and press Yes/Enter.
7. When the display reads “Accept Changes” press Yes/Enter for confirmation.
8. Press **No/Esc** to return to the Terminal Setup menu.
9. Press the down arrow (**F2**) key until the “Save and Exit” option is selected.
10. Press **Yes/Enter** to exit the Terminal Setup menu. This will reset the terminal and allow it to accept communication from the WinRemote software.

For information on configuring WinRemote for an Ethernet terminal, please refer to 19.0.2. Configuring and Starting an Ethernet Terminal in the User Reference Guide found on the CD.

### 1.1.4. Configuring the Fallback Timeout for a 200 Series Terminal

**Fallback Mode** is only a feature of the 200 Series Terminal. Please speak with a representative for more information: 1-800-749-8463.

The **200 Series Terminal** allows clock operations to be performed and punches to be stored inside the terminal when it does not have a real time connection with the software. This can be caused by network failure, a server being taken down for maintenance, etc. If the terminal loses communication with the software, the terminal’s TCP timeout, which is 60 seconds by default, begins. If the terminal does not re-establish communication within those 60 seconds then the connection is closed and the Fallback timeout timer, which is 30 seconds by default, begins. If the terminal does not re-establish communication within those 30 seconds then the terminal will enter Fallback Mode, at which point up to 2,000 punches may be stored inside the terminal. Once communication with the software has been re-established, the stored punches will be automatically retrieved from the terminal.

**To change the Fallback timeout**

1. Double click on the port or select it and click **Port > Configure**.
2. Click on the **Fallback Mode** tab and change the **Fallback timeout** to the desired length of time.
3. Click **OK**.

© Data Management, Inc. All Rights Reserved. This documentation may change without notice.
1.1.5. Frequently Asked Questions

Where can the Ethernet cable from the terminal be plugged in?

The Ethernet terminal can be plugged into any hub or switch that can host a computer as well as a Network Interface Card (NIC). You will have to use a crossover cable if you connect the Ethernet Terminal directly to a Network card.

What is the maximum cable length?

100 Meters

How can I find out what IP the terminal is running on?

When the terminal is online you can press the 1 button twice to have the terminal show you the IP as well as indicating how long the device has been online.

**Note!** This option will need to be enabled in WinRemote by configuring the port, clicking on the Terminal Operation tab, and enabling the option: Allow terminal identification by pressing “11” at the idle screen.

Can I convert a Serial terminal into an Ethernet terminal?

This is possible, but the terminal will need to be sent in. For a conversion, please call 1-800-749-8463 and make arrangements with your TimeClock Plus Sales Representative.

Troubleshooting

**Error:** “The system was unable to start the port…”

WinRemote will report this error if it is unable to take control of the IP specified in the software. The IP address may be in use by another computer or Ethernet terminal on the network. Disconnect the Ethernet terminal from the network, configure the port, click on the Ethernet tab, and click Ping. If the ping command receives a reply then the IP is currently in use by another device on the network. In this case, you must choose a new IP for the terminal. If there is no reply, reconnect the terminal and click Ping again. If there is still reply then verify that the settings on the terminal are correct (refer to steps 1-3 under Configuring a Series 100/200 Ethernet Terminal earlier in this section).

“Not connected, waiting 30 seconds”

This message will appear in WinRemote if the terminal loses its connection with the network or if the network becoming inaccessible. The software will wait 30 seconds before trying to reconnect to the terminal. This prevents the software from creating an unnecessary amount of network traffic while trying to reconnect to the terminal.
1.2. Serial Terminal

Product Components

- Terminal
- Wall-Mount
- Power Pack
- Serial Cable
- Adapter
- Barrel Keys

1.2.1. Wall Mount Installation

Location and Position

1. Locate wall-mount on smooth surface at a minimum height of 46” off the floor.

2. Align a bubble level with the top edge of the wall mount and gently rotate the mount until the bubble level shows that the top edge of the mount is level.

3. Using the mount as a template, mark the locations of the mount holes.

4. Remove mount and drills holes with appropriate hardware based on wall material.

Secure to Wall

5. Re-position wall-mount and fasten securely to wall.
1.2.2. Terminal Installation

Connection of Communications and Power

1. Connect power pack to the terminal’s **Power In** port.
2. Connect one end of the serial cable to the terminal’s **Serial Port to PC** on the Daughter Board located in the Wall-Mount.
3. Connect the other end of the serial cable to the adapter.
4. Connect the adapter to a serial port on the back of the computer that will control it.

5. Place terminal over the wall-mount, making sure to route the power and serial cable through the access hole at bottom or back of the mounting plate.
6. Hook terminal onto top hanger tabs. This will align the terminal on the wall-mount. Rotate bottom in while sliding upward until terminal drops into hanger tabs.
7. Slide the terminal down and close it. Be careful to not crush any electronic components within the terminal by forcing it closed. You may have to check for cable clearances within the terminal.
8. Secure terminal to wall mount with the barrel lock at the bottom.

Hang and Secure Terminal

For information on configuring WinRemote for a Serial terminal, please refer to 19.0.1. **Configuring and Starting a Serial Terminal** in the User Reference Guide found on the CD.

1.2.3. Configuring the Fallback Timeout for a 200 Series Terminal

**Fallback Mode** is only a feature of the 200 Series Terminal. Please speak with a representative for more information: 1-800-749-8463.

The **200 Series Terminal** allows clock operations to be performed and punches to be stored inside the terminal when it does not have a real time connection with the software. This can be caused by network failure, a server being taken down for maintenance, etc. If the terminal loses communication with the software, the

© Data Management, Inc. All Rights Reserved. This documentation may change without notice.
terminal’s Host timeout, which is 60 seconds by default, begins. If the terminal does not re-establish communication within those 60 seconds then the connection is closed and the Fallback timeout timer, which is 30 seconds by default, begins. If the terminal does not re-establish communication within those 30 seconds then the terminal will enter Fallback Mode, at which point up to 2,000 punches may be stored inside the terminal. Once communication with the software has been re-established, the stored punches will be automatically retrieved from the terminal.

To change the Fallback timeout

1. Double click on the port or select it and click Port > Configure.
2. Click on the Fallback Mode tab and change the Fallback timeout to the desired length of time.
3. Click OK.
1.3. Fingerprint Terminal

Depending on the type of Fingerprint terminal that you have purchased, please refer to either the Serial or Ethernet Terminal sections of this guide for information on connecting the device.

You will need to enable the fingerprint reader on the terminal and in WinRemote.

1.3.1 Enabling the Fingerprint Scanner on the Terminal

1. To configure the terminal, power it on and press F1 when the display reads "F1 for setup..."

   If the terminal is displaying “Waiting for Host” then it has already completed the boot process. Reset the power to the terminal and press F1 when prompted.

2. This will enter the Terminal Setup menu. Press F2 (down arrow) to select Aux Device and then press Yes/Enter to confirm the selection.
3. Press F1 and then select Fingerprint and then press Yes/Enter to confirm the selection. This will take you back to the main menu.
4. Press F2 to scroll down to Save and Exit and press Yes/Enter to save your settings.

You will now need to install and load the Cogent Fingerprint Module.

1.3.2. Fingerprint Module Installation

To install the Cogent Fingerprint Module:

1. Open Auto Update (Start > Programs/All Programs > TimeClock Plus 6.0 > AutoUpdate).
2. Click on the Module button.
3. Enter your module key for the Cogent Fingerprint Module in the Module Download window and click OK. This will be found on your invoice or you may call TimeClock Plus Customer Support (325-223-9300) to retrieve your key.
4. When asked if you would like to check for documentation, click Yes, to obtain the current version of the documentation.
5. Close AutoUpdate.
6. Open Module Manager (Start > Programs/All Programs > TimeClock Plus 6.0 > Module Manager).
7. Log in.
8. Click on the WinRemote tab, highlight the Cogent Fingerprint Module, and click Edit.
9. Place a check next to Load this module. If the use of this module is vital to operations then also check Halt application if module cannot be loaded.
10. Click OK and close Module Manager.

You will now need to configure the Cogent Fingerprint Module in WinRemote.

© Data Management, Inc. All Rights Reserved. This documentation may change without notice.

Rev. 2/18/11
1.3.3. Fingerprint Module Configuration

If WinRemote has not been configured for terminal connectivity then refer to the appropriate section before proceeding. For Ethernet, refer to the Ethernet Terminal section (1.1) and for Serial, refer to the Serial Terminal section (1.2).

Follow these steps to configure the module in WinRemote.

1. In WinRemote, double click on the port or select it and click Port > Configure.
2. Click on the Active Modules tab, highlight Cogent Fingerprint Module and click Configure.
3. Under the Settings tab, place a check next to Enable fingerprint unit on this terminal.

4. Make sure the Configuration access key has a key set, such as F1, etc. This is the key used to access the fingerprint enrollment screen on the terminal.

5. Choose between one-to-many and one-to-one verification.

© Data Management, Inc. All Rights Reserved. This documentation may change without notice.
**One-to-many:** Operations that verify the employee’s identity with the one-to-many approach will ask for the employee’s fingerprint and then search for a match.

**One-to-one:** Operations that verify the employee’s identity with the one-to-one approach will ask for the employee’s ID, then ask for the fingerprint, and compare the taken print with the print on file for that ID.

There are benefits of each. If you do not want the employee to enter their ID number and scan then one-to-many would be the best choice. However, if there are a lot of prints on file then one-to-one would be best. The one-to-one approach will always have a consistent verification time whereas the one-to-many approach, while more convenient, will have varying verification times based on the number of prints.

6. If you prefer the one-to-many approach then click on the Identification tab and place a check next to the operations that should require a fingerprint. Clock In, Clock Out, and Go on break are commonly checked. Operations left un-checked will not require a print.

7. If you prefer the one-to-many approach then click on the Verification tab and place a check next to the operations that should require an ID and print. Clock In, Clock Out, and Go on break are commonly checked. Operations left unchecked will not require a print.

8. Click OK.
1.3.4. Configuring an Employee to Always Skip the Scan

In some situations, you may not require an employee to verify his/her identity using their fingerprint.

1. Open TimeClock Manager (Start > Programs > TimeClock Plus 6.0 > TimeClock Manager).
2. Log in and go to Employee > Add/Edit.
3. Double click on the employee.
4. Go to the Custom tab.
5. Under Cogent FP WinRemote Module, there is an option: Skip Verification. If set to Yes, then this employee will not be required to scan during a clock operation.
6. Click Save.

1.3.5. Enrolling a Fingerprint

These are the only required steps to enroll on the terminal.

1. On the terminal, press the configuration access key defined in the Cogent Fingerprint Module configuration (F1 by default).
2. If the configuration access method selected in WinRemote was Management print then a message will appear that reads: A manager print is required for access but none are present. This message will only appear if there are no manager prints are on file.
3. Then a Maintenance menu will appear with the options for 1. Users, 2. Device, 3. Test.
4. Press 1 for Users.
5. Press 1 to Enroll.
6. Press 1 to enroll individual or 2 to enroll manager. 2 will only be an option if Use system to enroll management prints for overrides and access control is enabled in the Cogent Fingerprint Module configuration.

Enrolling an individual:

1. After selecting to enroll individual, enter in the employee ID number and press the Yes/Enter button.
2. A confirmation screen confirming your employee name or manager name will appear. Press Yes/Enter if this is the correct name.
3. Select which of your 5 fingers you want to enroll as print number.
4. Watch the display on the terminal for instructions. To enroll you will be required to place your finger on the finger reader two different times to obtain a valid fingerprint.

Enrolling a manager:

1. Specify which Manager you are in the Enroll Manager menu. When enrolling a manager you are asked to confirm which manager (user) you are. Press the Clock Out button to go to the next manager in the list, or press the Clock In button to go to the previous manager in the list.
2. Select which of your 5 fingers you want to enroll as print number.
3. Watch the display on the terminal for instructions. To enroll, you will be required to place your finger on the finger reader two different times to obtain a valid fingerprint.

Once the enrollment procedure is complete the employee can perform clock operations or the manager can authorize restricted clock operations.

When enrolling, pay special attention to your fingerprint position on the sensor. You want to make sure the fingerprint images captured are properly centered with even pressure applied and minimal rotation. For example, the same pressure should be used as if pressing a button on a telephone. Also make sure to have clean fingers when enrolling. Finally if you have a damaged area on a finger, then please enroll with a different finger. The images below show common problems with finger placement.

1.3.6. Other Important Settings

For more information about the required settings, please refer back to the earlier section (1.3.3. Fingerprint Module Configuration).

If any of these options need to be changed and more than one terminal is connected then these options will need to be changed for each port in WinRemote.

Settings Tab

Configuration access key: This determines which key on the terminal will open the enrollment screen (disabled or F1 - F8).

Configuration access method: When a manager presses the configuration access key to open the enrollment screen, the system will verify his/her identity using the method selected here.

- **Management print verification** will require managers to scan their finger to verify.
- **Management password** will require that managers to enter the password defined here.
- **Management print or password** will require the managers to scan their finger. If the scan is unsuccessful, it will require the managers to enter the password defined here.
If you enter a configuration access password, you will need to click Update Password.

Enrollment Tab

Use system to enroll management prints for overrides and access control: This will need to be checked if you choose to enroll managers. If this is not checked then the option to enroll managers will not be available.

- **Use default method for management overrides (User/Password):** If this option is selected, manager overrides (for clock restrictions, if any are enabled) will require the manager’s override password.
- **Use only management prints to perform overrides:** If this option is selected, manager overrides will require the manager’s fingerprint.
- **Attempt to use management print, then use default method if verification fails:** If this option is selected, manager overrides will require the manager’s fingerprint. If the print fails for any reason, they will require the manager’s override password.

The user’s override password is blank by default and must be created in TimeClock Manager (Configuration > User list > double click on the user’s name > Passwords tab).

Action to be taken if no prints are enrolled for an individual: This determines how a Series 200 terminal behaves in Fallback mode if an employee doesn’t have any fingerprints on file.

- **Reject punch** will prevent individuals who do not have at least one print on file from performing a clock operation while in Fallback mode.
- **Accept punch** will allow individuals who do not have at least one print on file to perform a clock operation while in Fallback mode.

1.3.7. Other Options on the Terminal for the Fingerprint Reader

These additional options may be found on the terminal (enrollment screen).

The Maintenance menu contains three different options:

**Users**
The first option on the Maintenance menu is **Users**. When you select this option, you will land on another menu with four options:

- **Enroll** - The first option on the Users menu is **Enroll**. This option will allow you to enroll (create a fingerprint for) an individual/employee or manager.
- **Delete** – The second option on the Users menu is **Delete**. This option will allow you to delete the fingerprint of an individual or manager. After selecting either, there will be two options: **Delete One** and **Delete All**. If you select **Delete One**, you will be prompted to choose which device the print should be deleted from: the database, the terminal, or both.
- **Count** - The third option on the Users menu is **Count**. The Record Count screen will give you a total count of fingerprints stored in the database and...
internally inside the terminal. The maximum number of fingerprints that can be contained inside the terminal is 1,336.

- **Sync** - The fourth option on the Users menu is **Sync**. This option will allow you to sync either one or all individual prints. To sync the prints means to sync the prints between the database and the reader (terminal). After choosing to sync the prints for an individual or for everyone, you will land on the Sync Direction menu.
  - **Sync Direction** - The first option in the Sync Direction menu will allow you to sync the fingerprints from the reader (the terminal) to the database. The second option will allow you to sync fingerprints from the database to the reader. The third option will allow you to sync prints between the reader and the database.

  *The Sync option should only be necessary if you have more than one terminal and have to re-enroll an employee. In that event, to ensure that each terminal has the latest copy of his/her fingerprint, perform a sync.*

**Device**
The second option on the Maintenance menu is **Device**. When you select this option, you will land on another menu with four options:

- **Info** – When you press 1 for **Info**, you will receive a Reader Information screen. This screen will give you information pertaining to your Cogent Fingerpint reader. This information contains the current version of firmware for your Cogent Fingerprint reader.
- **Reset** - When you press 2 to **Reset**, you will be sending a reset command to your biometric device. We do not recommend resetting your biometric device unless instructed to do so by a customer service representative.
- **Firmware** – When you press 3 for **Firmware**, you will be allowed to download a new version of firmware for your Cogent Fingerprint reader. You will only need to download new firmware if instructed to do so by a customer service representative.
- **Calibrate** - When you press 4 to **Calibrate**, you will be allowed to calibrate your Cogent Fingerprint reader. Please contact customer support if the operation fails to begin the troubleshooting process.

**Test**
The third option on the Maintenance menu is **Test**. After selecting the option for test you will then be allowed to type in an employee ID number and scan a finger to see if they have a fingerprint on file for that particular finger. If a fingerprint is not on file for that finger you can then enroll the finger from the **Enroll** menu.
1.4. Hand Scanner

Product Components

- Hand Scanner
- Wall Mount
- Cable
- Power Supply
- Hand Scanner Lock Keys

1.4.1. Wall Mount Installation

Wall Preparation

**Note!** Protect the hand scanner from the dust and debris generated during the wall plate installation process.

1. Remove the wall mount from the packing carton.
2. Measure and mark a point 48-1/2 inches (123 cm) from the surface of the finished floor. This point will correspond to where the top-center point of the hand scanner should be mounted.
3. For a hollow wall, drive a small nail into the wall at the mark and hang the wall plate from the leveling hole located near the top of the wall mount.
4. For a solid wall, hold the wall mount against the wall, centering the leveling hole over the mark in the wall.

© Data Management, Inc. All Rights Reserved. This documentation may change without notice.
5. Align a bubble level with the top edge of the wall mount and gently rotate the mount until the bubble level shows that the top edge of the mount is level.
6. Secure the mount to the wall using heavy masking tape.
7. Using the mount as a template, mark the locations of the two upper screw holes and the three lower screw holes.
8. For a concealed wiring connection, trace the outline of the open area in the center of the mount. Identify and mark a 1/2 inch hole through which the hand scanner’s wiring will run.
9. For a surface conduit wiring connection, mark the two conduit clamp holes at the right side of the wall plate.
10. Remove the wall plate, masking tape, and nail (if used).

Secure the Wall Mount

11. For a hollow wall, use the provided hardware to secure the wall mount. Use the two auger style fasteners for the two upper screw holes. Use the toggle bolts for the three lower screw holes.
12. For a solid wall, use expansion bolts to secure the wall mount. For all five mounting holes, drill a 1/4 inch diameter hole, 1/4 of an inch deeper than the length of the expansion anchor.

Routing the Wiring

13. For a concealed wiring connection, drill a 1/2 inch hole in a convenient location within the open area of the wall mount. Pull the wiring to the hand scanner through this hole in the open area.
14. For a surface conduit wiring connection, drill a 1/4 inch diameter hole, 1/4 of an inch deeper than the length of the expansion anchor for each of the two conduit clamp holes. Route 1/2 inch conduit to the hand scanner, ending the conduit between the two conduit clamp holes. Pull the wiring to enter the hand scanner through the conduit.

1.4.2. Hand Scanner Installation

Connection of Communications and Power

The hand scanner setup requires the purchase of a terminal. This terminal can be connected directly to a PC (Serial) or to a network (Ethernet) depending on the type of terminal.

1. Remove the hand scanner from its carton.
2. Remove the Terminal from its carton.
3. Connect the Terminal to the computer by connecting it to an available Ethernet port on your network or to a serial port on the computer that will control the unit. Refer to the Ethernet or Serial terminal sections of this manual to connect the terminal.

Hang and Secure Hand Scanner

4. Align the sleeves of the back plate with the pins of the wall mount and slide the hand scanner to the left to where the pins of the wall mount slide into the sleeves of the back plate.
Connecting the Hand Scanner to an Ethernet Terminal

If you have an Ethernet terminal, the hand scanner is connected differently than it is with a Serial Terminal. Skip to step 6 if you have a Serial Terminal.

5. Connect the hand scanner passthrough cable to the terminal by connecting it the AUX port found on the daughter board as shown in the following diagram. Verify the other connections match the following figure.

Connecting the Hand Scanner to a Serial Terminal

6. The hand scanner passthrough cable is connected to the Aux Port on the small rectangular daughter board connected to the Main Board by plastic standoffs. Verify the other connections match the following figure.

You will need to enable the hand scanner on the terminal and in WinRemote.
1.4.3. Enabling the Hand Scanner on the Terminal

1. To configure the terminal, power it on and press F1 when the display reads "F1 for setup..."

If the terminal is displaying "Waiting for Host" then it has already completed the boot process. Reset the power to the terminal and press F1 when prompted.

2. This will enter the Terminal Setup menu. Press F2 (down arrow) to select Aux Device and then press Yes/Enter to confirm the selection.
3. Press F1 and then select Hand scanner and then press Yes/Enter to confirm the selection. This will take you back to the main menu.
4. Press F2 to scroll down to Save and Exit and press Yes/Enter to save your settings.

You will now need to install and load the Handscanner Passthrough Module 6.0.

1.4.4. Hand Scanner Module Installation

To install the Hand Scanner module:

1. Open Auto Update (Start > Programs/All Programs > TimeClock Plus 6.0 > AutoUpdate).
2. Click on the Module button, enter your module key for the Hand Scanner Module in the Module Download window, and click OK. This will be found on your invoice or you may call TimeClock Plus Customer Support (325-223-9300) to retrieve your key.
3. Open Module Manager (Start > Programs/All Programs > TimeClock Plus 6.0 > Module Manager).
4. After logging in, under the WinRemote tab, highlight Hand Scanner Passthrough Module 6.0, and click on the Edit button.
5. Place a check next to Load this module. If the use of this module is vital to operations then also check Halt application if module cannot be loaded.
6. Click OK and close Module Manager.

1.4.5. Hand Scanner Module Configuration

If WinRemote has not been configured for terminal connectivity then refer to the appropriate section before proceeding. For Ethernet, refer to the Ethernet Terminal section (1.1) and for Serial, refer to the Serial Terminal section (1.2).

1. In WinRemote, double click on the port or select it and click Port > Configure.
2. Highlight the port and click Configure.
3. Click on the Modules tab.
4. Highlight the Hand Scanner Passthrough Module 6.0 and click Configure.
5. Place a check next to Enable hand scanner on this terminal.
6. It is recommended that the **Reader address** remain 0.
7. Click on the **Enrollment tab**.
8. Select the **Key used to access enrollment**.

9. Click on the **Verification tab**.
10. Place a check next to the operation that should require a hand scan. **Clock In**, **Clock Out**, and **Go on break** are commonly checked.

11. Click **OK** to close the Hand Scanner Configuration.
12. Click **OK** again to close the Port Configuration.

### 1.4.6. Enrolling a Handprint

1. On the terminal, press the key used to access enrollment defined in the Hand Scanner Module configuration.
2. If a manager scan is necessary, select the manager using the **Clock In** and **Clock Out buttons** to move through the list, and then press **Yes/Enter**.
3. After selecting the manager’s name, follow the instructions on the display of the terminal.
4. Press 1 to **Enroll Individual** or 2 to **Enroll Manager**. 2 will only be an option if **Use hand scanner to enroll managers** is enabled in the Hand Scanner Module configuration.

© Data Management, Inc. All Rights Reserved. This documentation may change without notice.
Enrolling an employee:

1. Enter the employee’s ID and press Yes/Enter.
2. If a scan already exists and you choose to replace it then press Yes/Enter. Otherwise press No/Esc.
3. Follow the instructions on the display of the hand scanner.

Enrolling a manager:

It is recommended that a manager enrolls on the hand scanner. This manager would need to be a user who will be available to authorize the enrollment of an employee. If there is not at least one manager scan on file then anyone will be able to enroll as another employee and perform clock operations for that employee.

1. Select the manager using the Clock In and Clock Out buttons to move through the list and then press Yes/Enter.
2. If a scan already exists and you choose to replace it then press Yes/Enter. Otherwise press No/Esc.
3. Follow the instructions on the display of the hand scanner.

1.4.7. Other Important Settings

For more information about the required settings, please refer back to the earlier section (1.4.5. Hand Scanner Module Configuration). The settings below are additional settings.

If any of these options need to be changed and more than one terminal is connected then these options will need to be changed for each port in WinRemote.

Enrollment Tab

Key used to access enrollment: This determines which key on the terminal will open the enrollment screen (disabled or F1 - F8).

Use hand scanner to enroll managers: This will need to be checked if you choose to enroll managers. If this is not checked then the option to enroll managers will not be available.

Enrollment Access: When a manager presses the configuration access key to open the enrollment screen, the system will verify his/her identity using the method selected here.

- Access enrollment using a management scan only will require managers to scan their hand to verify.
- Access enrollment using the enrollment password only will require managers to enter the password defined here.
- Access enrollment using password if management scan fails will require the managers to scan their hand. If the scan is unsuccessful, it will require the managers to enter the password defined here.
If you enter an enrollment password, you will need to click **Update Password**.

**Override Tab**

**When a management override is required what action should be taken:** This will determine the method of verification for a manager override (for clock restrictions, if they are enabled).

- **Use the default method to perform overrides:** If this option is selected, manager overrides (for clock restrictions, if any are enabled) will require the manager’s override password.
- **Use only a manager’s hand scan to perform overrides:** If this option is selected, manager overrides will require the manager’s handprint.
- **Use manager scan if successful but use default method if unsuccessful:** If this option is selected, manager overrides will require the manager’s handprint. If the print fails for any reason, they will require the manager’s override password.

The user’s override password is blank by default and must be created in TimeClock Manager (**Configuration** > **User list** > double click on the user’s name > **Passwords** tab).
1.5. Digital Output

Two optional digital output modes are supported by each Terminal. When you ordered your terminal, your TimeClock Plus account representative qualified your needs for either the K-27 Relay D.O or the K-54 power based D.O. If you are unsure of the D.O. that you have purchased please contact your TimeClock Plus Account Manager or TimeClock Plus Customer support.

Each D.O. module provides the ability to trigger a device when clocking in, clocking out, changing job codes, changing cost codes, going on break, or at certain times of the day.

1.5.1. Digital Output Module Installation

To install the Digital Output module:

1. Open AutoUpdate (Start > Programs/All Programs > TimeClock Plus 6.0 > AutoUpdate).
2. Click on the Module button, Enter your module key for the Digital Output Module in the Module Download window and click OK. This will be found on your invoice or you may call TimeClock Plus Customer Support (325-223-9300) to retrieve your key.
3. Open Module Manager (Start > Programs/All Programs > TimeClock Plus 6.0 > Module Manager).
4. After logging in, under the WinRemote tab, highlight Digital Output Module, and click on the Edit button.
5. Place a check next to Load this module. If the use of this module is vital to operations then also check Halt application if module cannot be loaded. Then click OK.

1.5.2. Digital Output Module Configuration

If WinRemote has not been configured for terminal connectivity then refer to the appropriate section before proceeding. For Ethernet, refer to the Ethernet Terminal section (1.1) and for Serial, refer to the Serial Terminal section (1.2).

1. In WinRemote, double click on the port or select it and click Port > Configure.
2. Click on the Active Modules tab.
3. Highlight the Digital Output Module and click Configure.
4. Under the Access tab, choose the clock operations that should act as a trigger and the length of time that the object being triggered should open or sound. For example, if you want a door to be unlocked for 10 seconds when a user clocks in then you would place a check next to Clock In and enter 10 in

© Data Management, Inc. All Rights Reserved. This documentation may change without notice.
the Seconds field next to Clock In. If you want a buzzer to sound for 5 seconds when a user clocks in and out then you would place a check next to Clock In and Clock Out, enter 5 in the Seconds field next to Clock In, and 5 in the Seconds field next to Clock Out.

5. Under the Timers tab, add a day, time, and length if the object should be triggered on a specific day and at a specific time.

6. Click OK to close the Digital Output Configuration.

7. Click OK again to close the Port Configuration.

1.5.3. K-27 Relay Wiring

The K-27 option is designed to trigger a device that has its own power source. Change-over or double-throw contacts control two circuits: One Normally-Open contact and one Normally-Closed contact with a common terminal. This type of configuration is commonly referred to as a “Form C” contact. Check the specifications for voltage and current for any AC or DC device that you are connecting the relay module to. The DO functionality of the Relay Module utilizes an AC (Alternating Current) up to one hundred twenty (120) volt, one ampere, form “C” relay or a DC (Direct Current) up to twenty-four (24) volt, two ampere, form “C” relay.

DMI recommends that a qualified electrician perform wiring in accordance with state and local electrical regulations.

The numbers are printed on the green board (not on the black terminal block) as shown below. Verify that each wire is attached securely in the correct screw terminal.

1.5.4. Connecting a Buzzer in a Normally-Open (N/O) Configuration

When wiring for a Normally-Open (N/O) connection the relay closes the circuit when triggered; the circuit is disconnected when the circuit is open. This type of configuration is commonly referred to as a “Form A” contact. The jumper located to the right of the data connection should never be changed. It is there for in-house testing purposes and will be used to accommodate future product development.

Before making any connections, ensure all power is disconnected from the terminal as well as the device being controlled.

1. Attach a 12-18 awg cable from Screw Terminal 4 (Common) of the K-27 board to the positive (+) connection on the power supply for the buzzer.

© Data Management, Inc. All Rights Reserved. This documentation may change without notice.
2. Attach a 12-18 awg cable from Screw Terminal 3 (Normally Open) of the K-27 board to the positive (+) connection on the buzzer.
3. Attach a 12-18 awg cable from the negative (-) connection on the buzzer to the negative (-) connection on the power supply.

![Diagram of power source, buzzer, and terminal block connections]

**Testing the Circuit from the Terminal**

1. Connect all data cables.
2. Reboot the clock.
3. When prompted to enter Setup (Look towards the bottom of the screen for F1 for setup along with a progression line) press the F1 key so that you are in Terminal Setup mode.
4. Select System Test.
5. Scroll down to Digital Output and press Yes/Enter > Yes/Enter.
6. To turn on the circuit, press 1. To turn off the circuit, press 0.

### 1.5.5. Connecting a Buzzer in a Normally-Closed (N/C) Configuration

When wiring a Normally-Closed (N/C) connection, the relay opens the circuit when triggered; the circuit is connected when the circuit is open. This type of configuration is commonly referred to as a “Form B” contact. The jumper located to the right of the data connection should never be changed. It is there for in-house testing purposes and will be used to accommodate future product development.

Before making any connections, ensure all power is disconnected from the terminal as well as the device being controlled.

1. Attach a 12-18 awg cable from Screw Terminal 4 (Common) of the K-27 board to the positive (+) connection on the power supply for the buzzer.
2. Attach a 12-18 awg cable from Screw Terminal 2 (Normally Closed) of the K-27 board to the positive (+) connection on the buzzer.
3. Attach a 12-18 awg cable from the negative (-) connection on the buzzer to the negative (-) connection on the power supply.
Testing the Circuit from the Terminal

1. Connect all data cables.
2. Reboot the clock.
3. When prompted to enter Setup (Look towards the bottom of the screen for F1 for setup along with a progression line) press the F1 key so that you are in Terminal Setup mode.
4. Select System Test.
5. Scroll down to Digital Output and press Yes/Enter.
6. To turn on the circuit, press 1. To turn off the circuit, press 0.

Connect and secure all wiring as shown below for an Ethernet or Serial Terminal with a K-27 Relay board.

Serial Terminal with K-27 Relay

![Serial Terminal with K-27 Relay diagram]

Ethernet Terminal with K-27 Relay

![Ethernet Terminal with K-27 Relay diagram]
1.5.6. K-54 Relay Wiring

Your Terminal is equipped with an optional Digital Output relay board. This option is designed to trigger a device that requires 12 volts DC power not to exceed 800 mA (milliamps). Check the specifications for voltage and current for any DC device that you are connecting the relay to.

DMI recommends that a qualified electrician perform wiring in accordance with state and local electrical regulations.

1.5.7. Connecting a Buzzer in a Normally-Open (N/O) Configuration

1. The K-54 device ships, by default, configured for a Normally-Open (N/O) circuit, there are no changes necessary.
2. Unplug the power pack from the wall so that there is no power to the hardware. Connect the power jumper cable from the K-54 board to the input power on the main board.
3. Connect the buzzer (or load) to the screw terminal on the bottom of the K-54 board. The positive wire should be connected to the positive (+) screw terminal (left side of the terminal block). The negative wire should be connected to the negative (-) screw terminal (right side of the terminal block).
4. Connect the power supply to the bottom barrel of the daughter (K-54) board and then plug the other end into the wall.

1.5.8. Other Important Settings

For more information about the required settings, please refer back to the earlier section (1.5.2. Digital Output Module Configuration).

If any of these options need to be changed and more than one terminal is connected then these options will need to be changed for each port in WinRemote.

Access

Perform these triggers in fallback mode: This option allows any triggers caused by a clock operation or a schedule under the Timers tab to be performed when the terminal even when the terminal has lost a connection with the software and is

© Data Management, Inc. All Rights Reserved. This documentation may change without notice.
collecting punches in Fallback Mode. This only applies to the 200 Series terminal.

"Perform these triggers in fallback mode" is not recommended if the digital output is for door access because the terminal, having lost a connection to the software will be unable to validate each individual's identity in Fallback Mode.

**QuickPunch is access only**: This option only applies to a terminal with a card reader. If enabled, a Quick Punch will trigger the Digital Output (D.O.) only instead of the Digital Output and clock operation. One useful application of this option is door access. For example, a company may choose to purchase a terminal with a card reader and D.O. port for door access only and expect the employee to perform the clock operation at his/her desk.

*Enable QuickPunch* must be enabled for this option to take effect. To enable, configure the port in WinRemote, click on the **Clock Operations** tab, place a check next to *Enable QuickPunch*, and click **OK**.

A *QuickPunch* is an option for terminals with a card reader. It allows employees to swipe a badge without having to first press **Clock In** or **Clock Out**. When they swipe their badge from the main menu, the system checks their status in the database and initiates the appropriate operation. Any operations besides clocking in and out will require the employee to press a button (e.g., going on a break).

For Fallback terminals (200 Series), *QuickPunch is not available when the terminal is in Fallback mode*. In Fallback mode, it cannot communicate with the database, which means it doesn't know whether the employee is clocked in or clocked out.

**Disable all keys from main screen**: This option will disable every button on the terminal, which will require the employee to perform a Quick Punch. Companies may choose to purchase a terminal with a card reader and D.O. port for door access only and expect the employee to perform the clock operation at his/her desk. These companies would likely choose to disable the buttons on the terminal (Clock In, Clock Out, etc.).

**Options**

**Log digital output events when used for access only**: This option will record digital output events if the option: *QuickPunch is access only*, found under the **Access** tab when configuring the Digital Output Module, is enabled. If enabled, each event will be recorded for the Digital Output Access Report.

**Log digital output events when triggered during a clock operation**: This option will record digital output events when a clock operation is performed. If enabled, each event will be recorded for the Digital Output Access Report. If the option: *QuickPunch is access only*, found under the **Access** tab when configuring the Digital Output Module, is enabled then this option will not be effective.
1.6. Secugen Hamster

The following instructions will aid you in the installation of the fingerprint scanner. After physically connecting the fingerprint scanner, it will be necessary to install the software that will configure your computer to use the scanner. It will be necessary to restart your computer several times as indicated in the following instructions. It is assumed that you have already installed and setup TimeClock Plus before you proceed setting up the fingerprint scanner.

1. Connect your fingerprint scanner to your computer’s USB port. Your computer should automatically detect that a new USB device has been connected. If not, you may need to restart your computer.
2. When prompted to install the driver, browse to the TimeClock Plus 6.0 CD, and select the driver.

1.6.1. Secugen Hamster Module Installation

To install the Secugen Hamster Module:

1. Open AutoUpdate (Start > Programs/All Programs > TimeClock Plus 6.0 > AutoUpdate)
2. Click on the Module button.
3. Enter your module key for the Secugen Hamster Module in the Module Download window and click OK. This will be found on your invoice or you may call TimeClock Plus Customer Support (325-223-9300) to retrieve your key.
4. When asked if you would like to check for documentation, click Yes, to obtain the current version of the documentation.
5. Close AutoUpdate.
6. Open Module Manager (Start > Programs/All Programs > TimeClock Plus 6.0 > Module Manager)
7. Log in.
8. Click on the On-Screen TimeClock tab, highlight the Secugen Hamster Module, and click Edit.
9. Place a check next to Load this module. If the use of this module is vital to operations then also check Halt application if module cannot be loaded. Then click OK.
10. Close Module Manager.

1.6.2. Secugen Hamster Module Configuration

1. Open On-Screen TimeClock (Start > Programs/All Programs > TimeClock Plus 6.0 > On-Screen TimeClock).
2. Right click on the title bar of On-Screen TimeClock
3. Select Configure Modules.
4. Log in.
5. Highlight the Secugen Hamster Module and click Configure.
6. Under the Settings tab, select FDU03 for the device type. The device type is found on the bottom of the Hamster (it is a portion of the model number). For example, the model number HFDU03FRS is an FDU03.
7. Under the **Verification** tab, select **Manual, 1:Many**, or **1:1**.
   - **None** - If the authentication is none then the system will ask for the employee’s ID. Select this for any operations that should **not** require a finger scan (if any).
   - **1:Many** - Operations that authenticate with the one-to-many approach will ask for the employee’s fingerprint and then search all of the prints on file for a match.
   - **1:1** - Operations that authenticate with the one-to-one approach will ask for the employee’s ID, then ask for the fingerprint, and compare the taken print with the print on file for that ID.

   ![Secugen Configuration](image)

   **There are benefits of each. If you do not want the employee to enter their ID number and then scan then one-to-many would be the best choice. However, if there are a lot of prints on file or the quality of prints has caused several failures then one-to-one would be the best choice. The one-to-one approach is always going to be a consistent verification time whereas the one-to-many approach, while more convenient, will have varying verification times based on the number of prints.**

8. Click **OK** to close the Secugen Finger Scan Module window and **OK** again to close the TimeClock Options.
9. Close and re-open On-Screen TimeClock.

### 1.6.3. Enrolling an Employee

1. In On-Screen TimeClock, right click on the title bar.
2. Select **Configure Modules**.
3. Log in.
4. Highlight the **Secugen Hamster Module** and click **Configure**.

© Data Management, Inc. All Rights Reserved. This documentation may change without notice.
5. Select the **Individual Scans** tab.
6. Highlight the employee in the list and click **Enroll**.

![Individual Scans Tab](image)

7. Place the employee’s finger on the scanner.
8. When there is a clear and distinct fingerprint for Image 1, click **Capture**.

![Capture Image 1](image)

9. Lift the employee's finger off of the scanner when instructed.
10. Place the employee’s finger back on to the scanner. This is required for a second capture.
11. When there is a clear and distinct fingerprint for Image 2, click **Capture**.

![Capture Image 2](image)

### 1.6.4. Enrolling a Manager

1. In On-Screen TimeClock, right click on the title bar.
2. Select **Configure Modules**.
3. Log in.
4. Highlight the **Secugen Hamster Module** and click **Configure**.
5. Select the **Management Scans** tab.
6. Highlight the user in the list and click **Enroll**.
7. Place the manager’s finger on the scanner.
8. When there is a clear and distinct fingerprint for Image 1, click Capture.

9. Lift the employee’s finger off of the scanner when instructed.
10. Place the employee’s finger back on to the scanner. This is required for a second capture.
11. When there is a clear and distinct fingerprint for Image 2, click Capture.

1.6.5. Other Important Settings

For more information about the required settings, please refer back to the earlier section (1.6.2. Secugen Hamster Module Configuration).

Settings

Configure (next to the Device Type): The brightness, contrast, and gain device are adjusted here. These settings control the clarity of the device.

- **Brightness**: This slider controls the brightness of the fingerprint image. The higher the percentage of brightness, the more light will be let into the picture.
- **Contrast**: This slider controls the contrast in lines of the fingerprint image. The higher the percentage of contrast, the more distinct the lines of the image will be.
- **Gain**: This slider controls a combination of light and contrast in the image. The higher the gain setting results in less contrast and brightness.
• **Preview**: This button creates a live image of the finger currently placed on the device. This option allows users to see the results of their changes to the brightness, contrast, and gain.

• **Auto Exposure**: This button sets the brightness, contrast, and gain automatically to an optimal exposure.

**Use management prints to perform overrides**: If enabled, managers will be able to use their fingerprint to perform an override on a clock restriction (if any are enabled) instead of entering an override password.

**Verification security level**: This setting determines how sensitive the scanner should be. The higher the verification level, the more accurate the fingerprint has to be. The system allows for different variances in fingerprint reads because it would be difficult to place your finger on the scanner the exact same way every time. By setting this higher you reduce the odds of a false print being verified. If this is increased, the print has to be more accurate to the originals to pass verification. Decreasing this will increase the odds of a false print being verified.

**Attempt to auto sense proper finger placement during an identification**: If enabled, the scan will be automatically captured and identified during a clock operation once it reaches 100 percent. If this is not enabled then the employee will have to click **OK** to capture the scan.
1.7. CCD Scanner

CCD Scanner Installation

1. Plug the cable connector into the cable interface port on the bottom of the scanner’s handle.
2. Plug the other end of the cable in the Scanner port on the back of the terminal as shown on the next page.
Performing a Clock Operation

1. Press the desired operation (Clock In or Clock Out, for example).
2. On the Enter Employee ID# screen, scan your badge using the CCD Scanner.
3. On the confirmation screen (if enabled), press Yes/Enter if the information is correct.

Ensure the scan line crosses every bar and space of the symbol. Upon successful decode, the scanner beeps and the LED turns green.

Enabling the option: Enable QuickPunch will allow you to scan the badge without pressing Clock In or Clock Out. To enable, configure the port in WinRemote, click on the Clock Operations tab, place a check next to Enable QuickPunch, and click OK. In order to perform other operations such as going on break or changing job code, you will have to press the appropriate key.

For Fallback terminals (200 Series), QuickPunch is not available when the terminal is in Fallback mode. In Fallback mode, it cannot communicate with the database, which means it doesn’t know whether the employee is clocked in or clocked out.
1.8. Serial Scanner

Serial Scanner Installation

1. Plug the cable connector into the cable interface port on the bottom of the scanner’s handle.
2. Connect the other end of the cable to the COM port on your computer.
3. Connect the power supply to the cable.

Serial Scanner Configuration

1. Open On-Screen TimeClock (Start > Programs/All Programs > TimeClock Plus 6.0 > On-Screen TimeClock).
2. Right click on the title bar of On-Screen TimeClock
3. Select Configure Modules.
4. Log in.
5. Highlight the configuration and click Select.
6. Click on the Scanner tab.
7. Set the Port Address to the COM port where the serial scanner is connected.
8. Set the Baud rate to 9600.
9. Set the Settings to N,8,1.
10. Select the Start and Stop characters for your badges. Or choose 0 to disable the start and stop characters.
11. Click OK.

Performing a Clock Operation

1. Press the desired operation (Clock In or Clock Out, for example).
2. On the Enter Employee ID# screen, scan your badge using the CCD Scanner.
3. On the confirmation screen (if enabled), press Yes/Enter if the information is correct.

Ensure the scan line crosses every bar and space of the symbol. Upon successful decode, the scanner beeps and the LED turns green.

Enabling the option: Allow QuickPunch from the main window will allow you to scan the badge without pressing Clock In or Clock Out. To enable, right click on the title bar of On-Screen TimeClock, click Configure Settings, log in, highlight the configuration and click Select, click on the Scanner tab, place a check next to Allow QuickPunch from the main window, and click OK. In order to perform other operations such as going on break, you will have to press the appropriate key.
1.9. Power Over Ethernet

1.9.1. Injected Power Over Ethernet

Included is a Remote Power Injector Module. Some important highlights:

- Only the supplied power injector supplied by TimeClock Plus should be used.
- No special cables are required for either the Ethernet or Serial connections.
- Power is present on the terminal jack labeled TO TERMINAL.
- Power is not present on the terminal jack labeled TO HOST.

**DO NOT CONNECT THE POWER SUPPLY TO THE OUTLET UNTIL STEP 7.**

**Determine Location for Remote Power Injector Module**

1. Ensure that the location of the adapter is within 6 feet of an 110V AC outlet.
2. Ensure that the location will not exceed the specified maximum length for the communications being deployed. Ethernet max: 100m (300')

**Connections**

3. Verify that the Internal POE Board is connected to the primary power port on the main board as shown on the next page.
4. Connect one end of an Ethernet cable to your switch and the other end to the LAN port on the Power Over Ethernet injector box.
5. Connect one end of another Ethernet cable to the PoE port on the Power Over Ethernet injector box.
6. Plug the PoE injector box into a DC outlet (DC IN port). The Power LED in the center should light up.
7. Separate the wall mount from the face plate of the terminal. Insert the barrel key into the bottom of the unit and unlock the two pieces. Separate the two pieces and lay them side by side.
8. Thread the Ethernet cable from the Power Over Ethernet injector box through the cable access hole in the back plate and under the cable management system as shown below.
9. Connect the Ethernet cable to the J2 FROM NETWORK port on the Power Over Ethernet adapter board.
10. Connect the short Ethernet cable from the J1 TO TERMINAL port on the Power Over Ethernet adapter board to the Ethernet port on the motherboard. The terminal should now be powering up.

**If your terminal does not power up immediately, please call TimeClock Plus Technical Support for troubleshooting.**
1.9.2. Power Over Ethernet

The 802.3af POE Standard is supported by the 100/200 Series Terminals.

Setup is similar to the Injected Power Over Ethernet setup except a Power Injector Module is not required.

Because the router powers the terminal, it is connected directly to the Internal POE Board.

You will need to verify that your router or switch is 802.3af compliant. If it is not, you risk damage your RDT.

THE ETHERNET CABLE FROM THE POWER OVER ETHERNET SWITCH / ROUTER MUST BE CONNECTED TO THE INTERNAL POE BOARD. IF YOU ATTEMPT TO CONNECT IT TO THE STANDARD ETHERNET PORT ON THE TERMINAL, YOU MAY DAMAGE IT.
Connections

1. Verify that the **Internal POE Board** is connected to the primary power port on the main board as shown on the next page.
2. Connect the Router or Switch to the **Internal POE Board** with a standard CAT 5 patch cable. (included)
3. The Terminal should now power up.
4. Refer to the Ethernet documentation in this manual to set the internal configurations of the terminal.

*If your terminal does not power up immediately, please call TimeClock Plus Technical Support for troubleshooting.*
1.10. UPS Battery Backup

The TimeClock Plus Battery Backup can be installed with the 100 and 200 Series terminals to prevent downtime during a power outage. This Battery backup device is typically installed within the terminal prior to shipping. The power regulation card and rechargeable battery cells lie hidden in the wall mount behind the clock. The power cells provide alternative power to a 100 or 200 Series terminal for up to 1.5 hours during a power outage.

**Note!** The additional use of peripheral devices such as CCD Scanners, Barcode Readers, or the use of Biometric Fingerprint reader will reduce the expected life of the battery.

Connection of the Device

Certain components used in electronic assemblies are sensitive to static electricity and can be damaged by its discharge. Static charges are created when non-conductive materials are separated, such as when plastic bags are picked up or opened, when friction occurs between articles of synthetic clothing, when plastic tapes are dispensed and many other causes. If you find it necessary to handle the electronic components, they should be handled by the edges when possible.

**Avoid touching the component leads.**

1. Separate the wall mount from the face plate of the terminal. Insert the barrel key into the bottom of the unit and unlock the two pieces. Separate the two pieces and lay them side by side as shown on the next page.
2. Connect the battery backup connector to the port labeled **Battery Backup** as shown on the next page.
3. The battery backup should be allowed to charge for at least 8 hours before use.